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1

1.1

1.1.1

Installing the Operating System

Depending on the model, Microsoft Windows XP Home or Windows XP Professional is
preinstalled on the computer and will be configured automatically the first time the computer is
turned on.

CAUTION: Do not add optional hardware devices to your computer until the operating system is
successfully installed. Doing so may cause errors and may prevent the operating system from installing

properly.

CAUTION: Once the automatic installation has begun, DO NOT TURN OFF THE COMPUTER UNTIL
THE PROCESS IS COMPLETE. Turning off the computer during the installation process might damage the
software that runs the computer.

Microsoft Windows XP

Thefirst time the computer is turned on, Microsoft Windows is automatically installed. This
takes approximately 10 minutes, depending on the system hardware configuration. Read and
follow the instructions that appear on the screen to complete the installation. During this process,
do not turn off your computer unless you are directed to do so.

Installing or Upgrading Device Drivers

To install optional hardware devices after the OS installation is completed, you must install the
device driversfor the device you are installing.

The 1386 directory and its subdirectories provide the HP- or Compag-specific integration of the
operating system for the computer model and include device drivers supported by the operating
system.

When prompted for the 1386 directory on the operating system CD, replace the path specification
with C:\I386 or use the Browse button of the dialog box to browse the computer for the 1386
folder. This action points to the appropriate drivers.

The latest support software is also available from the Web site at http://www.hp.com/support.
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Installing the Operating System

1.2 Converting to NTFS

1.2.1 Windows XP Home and XP Professional

The Windows XP Home and XP Professional operating systems handle only NTFS-formatted
drives. When installed, XP will, if necessary, automatically convert aFAT32 driveto NTFS.

1.3 HP Software

The Microsoft Windows XP Home or Windows XP Professional operating systemis preinstalled
on the computer and will be configured automatically the first time the computer is turned on.
All other software is user-installed.

Certain drivers and utilities are available only in selected languages. You can obtain the latest
version of thesefiles, in English and selected other languages, in one of these ways:

m  HPwebsiteat www.hp.com
m  Compaq Restore CD, which is supplied with many Compag models

|:| Additional HP software may be required in certain situations.
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21

Setup Utilities and Diagnostics Features

Setup Utilities (F10) and diagnostic features provide information needed about the computer
system when contacting Customer Support. These tools can also be used to:

m  Change factory default settings and to set or change the system configuration, which may be
necessary when you add or remove hardware.

m  Determineif al of the devicesinstalled on the computer are recognized by the system and
functioning properly.

m  Determine information about the operating environment of the computer.

m  Solve system configuration errors detected but not automatically fixed during the Power-On
Self-Test (POST).

m  Establish and manage passwords and other security features.
m  Establish and manage energy-saving timeouts.

All features identified in this chapter may not be available on all HP products.

Power-On Self-Test (POST)

POST is aseries of diagnostic tests that runs automatically when the system is turned on. POST
checks the following items to ensure that the computer system is functioning properly:

m  Keyboard

= Memory modules

m Diskette drives

m  All IDE and SCSI mass storage devices
m  Processors

m  Controllers

If the Power-On Password is set, akey icon appears on the screen while POST is running. You
will need to enter the password before continuing. Refer to Chapter 3, Section 3.1, “Initial
Configuration and Deployment,” for information on setting, deleting, or bypassing the password.

If POST finds an error in the system, an audible and/or visual message occurs. For POST error
messages and their solutions refer to Appendix C, “POST Error Messages.”
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2.2 Computer Setup Utilities
Use Computer Setup Utilities (F10) to:

Modify or restore factory default settings.
Set the system date and time.

Set, view, change, or verify the system configuration including settings for processor,
graphics, memory, audio, storage, communications, and input devices.

Modify the boot order of bootable devices such as hard drives, diskette drives, optical drives,
or LS-120 drives.

Configure the boot priority of IDE (ATA) and SCSI hard drive controllers.
The system is preset to aways Quick Boot.

Enable or disable Network Server Mode, which allows the computer to boot the operating
system when the power-on password is enabled with or without a keyboard or mouse
attached. When attached to the system, the keyboard and mouse remain locked until the
power-on password is entered.

Enable power-on password prompting during system restarts (warm boots) as well as during
power-on.

Establish a setup password that controls access to Computer Setup (F10) Utility and the
settings described in this section.

Secure the integrated 1/O functionality, including the serial, USB, or parallél ports, audio, or
embedded NIC, so that they cannot be used until they are unsecured.

Enable or disable removable media boot ability.
Enable or disable removable mediawrite ability (when supported by hardware).

Solve system configuration errors detected but not automatically fixed during the Power-On
Self-Test (POST).

Execute self-tests on a specified IDE (ATA) hard drive (when supported by the drive).

2.2.1 Using Computer Setup (F10) Utilities

Computer Setup can be accessed only by turning on the computer or restarting the system. To
access the Computer Setup Utilities menu, complete the following steps:

1. Turn on or restart the computer. If you are in Windows, click Start > Shut Down > Restart.
2. As soon as the computer is turned on, press and hold the F10 key until you enter Computer

Setup. Press Enter to bypass the title screen, if necessary.

|:| If you do not press the F10 key at the appropriate time, you must turn the computer off, then on
again, and press the F10 key again to access the utility.

If you are using a PS/2 keyboard, you may see a Keyboard Error message—disregard it.

3. Select your language from the list and press the Enter key.
4. A choice of four headings appears in the Computer Setup Utilities menu: File, Storage,

Security, and Advanced.

2-2
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5. Use the arrow (left and right) keys to select the appropriate heading. Use the arrow (up and
down) keys to select the option you want, then press Enter. To return to the Computer Setup
Utilities menu, press Esc.

6. To apply and save changes, select File > Save Changes and EXxit.

O If you have made changes that you do not want applied, select gnore Changes and
Exit.

O Toreset to factory settings, select Set Defaults and Exit. This option will restore the
original factory system defaults.

CAUTION: Do NOT turn the computer power OFF while the ROM is saving your F10 Computer Setup
changes because the CMOS could become corrupted. It is safe to turn off all power to the computer
affer you exit the F10 Setup screen.
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2.2.2 Computer Setup Menu

Heading

Option Description
System None Lists product name, processor type and speed, cache size (L1/
Information L2), installed memory size, Chipset type, BIOS version, BIOS
release date, and CPU ID.
Standard System time (hh/ Sets the system time (24 hour format).
CMOS Setup  mm/ss)
System date (mm/  Sets the system date.
dd/yy)
Floppy drive A Calculates the size and capacity of the floppy drive.
Primary IDE Auto detects which hard drive is the primary master drive.
Master
Primary IDE Slave  Auto detects which hard drive is the primary slave drive
Secondary IDE Auto detects which hard drive is the secondary master drive.
Master
Secondary IDE Auto detects which hard drive is the secondary slave drive.
Slave
Advanced Add-On ROM * Force BIOS: Add-On ROM displayed (default)
CMOS Sefup  Display Mode * Keep Current: Add-On ROM not displayed
POST Delay Time  Sets the amount of time before the Setup Utility prompt
(seconds) (F10=Setup) appears when the computer boots.
* None: POST delay time disable (default)
* 5: POST delay of 5 seconds
* 15: POST delay of 15 seconds
* 25: POST delay of 25 seconds
* 35: POST delay of 35 seconds
System Keyboard Detects if a keyboard is present when the computer boots
Absent: keyboard not detected (default)
Present: keyboard detected
APIC ACPI SCI Enables or disables the internal I/O APIC and Multiprocessor
IRQ Tables. (Disabling the APIC ACPI SCI IRQ may require you to
reinstall the operating system.)
* Enable: IRQ 20-23 (default)
* Disable: IRQ 09-11
Hyper-Threading Enables or disables the Intel Hyper-Threading Technology. (This
Technology item is only selectable with the Intel HTT CPU plug-in.)
* Enable: Intel HTT function enable (BIOS auto detect).
* Disable: Intel HTT function disable (BIOS auto detect).
Boot Device Specifies the boot order for all devices.
Priority
2-4 359782-002 Service Reference Guide, dx2000 uT
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Heading Option Description
] Support for Computer Setup options may vary depending on your specific hardware configuration.
Advanced Internal Graphic Selects the size of memory for internal graphics adapter.
CMOS Serp Mode Select e 1MB: Share TMB
(Continued)

* 4MB: Share 4MB

* 8MB: Share 8MB (default)
* 16MB: Share 16MB

* 32MB: Share 32MB

Power ACPI Standby Sets the ACPI standby state when system goes into ACPI
Management  State standby mode.
Setup

* S1/PSOS: power on suspend
* S3/STR: Suspend to RAM (default)

Restore on AC/ Sets the system status after AC power loss.

Power Loss * Power Off: System always powers off (Default)
* Power On: System always powers on
* Last State: System returns to the last state before AC power
loss
Resume on Ring Sets the Resume On Ring from soft off.
* Disable: Ring Resume disable (default)
* Enable: Ring Resume enable
Resume on PME Sets the Resume On PME from soft on.
* Disable: PME Resume disable
* Enable: PME Resume enable (default)
Peripheral OnBoard LAN Enables or disables the OnBoard LAN.
Setup * Disable: OnBoard LAN disabled
* Enable: OnBoard LAN enabled (default)
OnBoard LAN Enables or disables the OnBoard LAN Chip Boot ROM.
Chip Boot ROM * Disable: OnBoard LAN Chip Boot ROM disabled
* Enable: OnBoard LAN Chip Boot ROM enabled (default)
Init. Graphics Sets the initial priority of the graphics adapter.
Adapter Priority « VGA/PCI
* PCl/Int-VGA (default)
USB Function Enables or disables the USB controller.

* Disable: USB controller disabled
* Enable: USB controller enabled (default)

M Support for Computer Setup options may vary depending on your specific hardware configuration.
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Heading Option Description
Peripheral USB 1.1 Device Sets the USB 1.1 Device Legacy Support under DOS mode.
Setup Legacy Support * Disable: USB 1.1 Device Legacy Support disabled
(Continued) * No Mice: A mouse is not supported
* All Devices: All devices are supported (default)
OnBoard Serial Sets the OnBoard Serial Port settings
Port * Auto (default)
* Disable
* 3F8/IRQ4
* 2F8/IRQ3
* 3E8/IRQ2
* 2E8/IRQ1
OnBoard Parallel  Sets the OnBoard Parallel Port settings.
Port « SPP (Bi-Dir)
* SPP and EPP-1.9
* ECP
* ECP and EPP-1.9 (Default)
Hardware CPU Warning Warns when CPU temperature is greater than 85°C/185°F.
Monitor Temperature
CPU Shutdown System will shutdown when CPU temperature is greater than
Temperature 90°C/194°F,

System Warning
Temperature

Warns when system temperature is greater than 60°C/140°F.

System Shutdown
Temperature

System will shutdown when system temperature is greater than
65°C/149°F.

CPU Temperature

Detects current CPU temperature.

M Support for Computer Setup options may vary depending on your specific hardware configuration.
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Heading Option Description
Hardware System Detects current system temperature.
Monitor Temperature
(Continued)

CPU FAN Speed Detects CPU fan speed.

Chassis FAN Detects current chassis fan speed.

Speed

CPU VID Detects current CPU voltage.

Veep Detects current Vccp voltage.

+1.5V Detects current ATX power +1.5V.

+2.5V Detects current ATX power +2.5V.

+3.3V Detects current ATX power +3.3V.

+5.0V Detects current ATX power +5.0V.

+12.0V Detects current ATX power +12.0V.

HVcc Detects current HVcc voltage.
Password Change Allows you to set and change the supervisor password.
Option Supervisor

Password

Password Status

Shows password status

Password Check

Allows you to set the password check when the supervisor
password is set up.

* Setup: Password prompt appears when BIOS is executed.

* Always: Password verification is checked every time the
computer boots (default).

load Default  None Loads the optimal default values for all the setup options.
Settings

Save Seftings  None Saves changes and exits setup.

and Exit

Exit Without ~ None Allows you to exit setup without saving any changes.
Savings

] Support for Computer Setup options may vary depending on your specific hardware configuration.
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2.3 Protecting the Software

To protect software from loss or damage, you should keep abackup copy of al system software,
applications, and related files stored on the hard drive. See the operating system or backup utility
documentation for instructions on making backup copies of datafiles.

2.4 Restoring the Software

The Windows operating system and software can be restored to its original state by using the
Restore CD. See the Restore CD for complete instructions on using this feature.
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3

3.1

3.2

Desktop Management

HP Intelligent Manageability provides standards-based solutions for managing and controlling
desktops, workstations, and notebook PCsin a networked environment.

The capabilities and features of the seven key components of desktop management are;
= Initia configuration and deployment

s ROM flash

m  Security

Support for specific features described in this guide may vary by model or software version.

Initial Configuration and Deployment

HP computers come with a preinstalled system software image. After a brief software
“unbundling” process, the computer is ready to be used.

A customized software image may be deployed by:

m Installing additional software applications after unbundling the preinstalled software image.

m  Using software deployment tools, such as Altiris Deployment Solutions, to replace the
preinstalled software with a customized software image.

m  Using adisk cloning process to copy the contents from one hard drive to another.

The best deployment method depends on your information technology environment and
processes. The PC Deployment section of the Solutions and Services Web site http://
h18000.www 1.hp.com/solutions/pcsolutions provides information to help you select the best
deployment method.

The Restore Plus! CD, ROM-based setup, and ACPI hardware provide further assistance with
recovery of system software, configuration management and troubleshooting, and power
management.

ROM Flash

The computer comes with a reprogrammable flash ROM (read only memory). By establishing a
setup password in Computer Setup (F10) Utility, you can protect the ROM from being
unintentionally updated or overwritten. Thisisimportant to ensure the operating integrity of the
computer. Should you need or want to upgrade your ROM, you may:

m  Order an upgraded ROMPag™ diskette from HP.
m  Download the latest ROM Pag images from http://www.hp.com/support.
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Desktop Management

3.2.1 FailSafe Boot Block ROM

The FailSafe Boot Block ROM allows for system recovery in the unlikely event of a ROM flash
failure, for example, if a power failure wereto occur during a ROM upgrade. The Boot Block is
aflash-protected section of the ROM that checks for avalid system ROM flash when power to
the system is turned on.

m If the system ROM isvalid, the system starts normally.

m |f the system ROM fails the validation check, the FailSafe Boot Block ROM provides
enough support to start the system from a ROMPaq diskette, which will program the system
ROM with avalid image.

To recover the system after it enters Boot Block recovery mode, complete the following steps:
1. If thereis a diskette in the diskette drive, remove the diskette and turn off the power.
. Insert a ROMPaq diskette into the diskette drive.
. Turn on power to the system.
. If no ROM Paq diskette is found, you will be prompted to insert one and restart the computer.

a b~ WD

. If the system successfully starts from the diskette and successfully reprograms the ROM,
then the three keyboard lights will turn on.

6. Remove the diskette and turn the power off.
7. Turn the power on again to restart the computer.

3.2.2 Dual-State Power Button

With Advanced Configuration and Power Interface (ACPI) enabled for Windows XP, the power
button can function either as an on/off switch or as a suspend button. The suspend feature does
not completely turn off power, but instead causes the computer to enter alow-power standby.
This allows you to quickly power down without closing applications and to quickly return to the
same operational state without any data loss.

To change the power button’s configuration, complete the following steps:

1. Left click on the Start Button, then select Control Panel > Perfor mance and
M aintenance > Power Options.

2. Inthe Power Options Properties, select the Advanced tab.
3. Inthe Power Button section, select the desired power button setting.

After configuring the power button to function as a suspend button, press the power button to put
the system in avery low power state (suspend). Press the button again to quickly bring the
system out of suspend to full power status. To completely turn off all power to the system, press
and hold the power button for four seconds.

CAUTION: Do not use the power button to turn off the computer unless the system is not responding;
turning off the power without operating system interaction could cause damage to or loss of data on the

hard drive.
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3.2.3 Power Management

Power Management is a feature that saves energy by shutting down certain components of the
computer when they are not in use, saving energy without having to shut down the computer.

With Advanced Configuration and Power Interface (ACPI) enabled for Windows 2000 and
Windows XP, timeouts (the period of inactivity alowed before shutting down these components)
can be enabled, customized, or disabled using the operating system.

1. In Windows 2000, left click on the Start Button, then select Settings > Control Panel >
Power Options.

In Windows XP, l€eft click on the Start Button, then select Control Panel > Power
Options.

2. Inthe Power Options Properties, select the Power Schemes tab.
3. Select the desired power scheme settings.

Use Display Properties to establish, modify, or disable Power Management settings for the
monitor. To access Display Properties, right click on the Windows Desktop, then choose
Properties.

3.2.4 World Wide Web Site

When making the transition to new or revised operating systems, it isimportant to implement the
support software designed for that operating system. If you plan to run aversion of Microsoft
Windows that is different from the version included with your computer, you must install
corresponding device drivers and utilities to ensure that all features are supported and
functioning properly.

HP has made the task of locating, accessing, evaluating, and installing the latest support software
easier. You can download the software from http://www.hp.com/support. The Web site contains
the latest device drivers, utilities, and flashable ROM images needed to run the latest Microsoft
Windows operating system on your HP compulter.
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3.3
3.3.1

Security

Password Security

The power-on password prevents unauthorized use of the computer by requiring entry of a
password to access applications or data each time the computer is turned on or restarted. The
setup password specifically prevents unauthorized access to Computer Setup, and can also be
used as an override to the power-on password. That is, when prompted for the power-on
password, entering the setup password instead will allow access to the computer.

A network-wide setup password can be established to enable the system administrator to log into
al network systemsto perform maintenance without having to know the power-on password,
even if one has been established.

3.3.2 Establishing a Setup Password Using Computer Setup

[]

Establishing a setup password through Computer Setup prevents reconfiguration of the computer
(use of the Computer Setup (F10) utility) until the password is entered.

1. Turn on or restart the computer. If you are in Windows, click Start > Shut Down > Restart.

2. As soon as the computer is turned on, press and hold the F10 key until you enter Computer
Setup. Press Enter to bypass the title screen, if necessary.

If you do not press the F10 key at the appropriate time, you must turn the computer off, then on
again, and press the F10 key again to access the utility.

If you are using a PS/2 keyboard, you may see a Keyboard Error message—disregard it.

3. Select Security, then select Setup Passwor d and follow the instructions on the screen.
4. Before exiting, click File > Save Changes and Exit.

3.3.3 Establishing a Power-On Password Using Computer Setup

Establishing a power-on password through Computer Setup prevents access to the computer
when power isturned on, unless the password is entered. When a power-on password is set,
Computer Setup presents Password Options under the Security menu. Password options include
Password Prompt on Warm Boot. When Password Prompt on Warm Boot is enabled, the
password must also be entered each time the computer is rebooted.

1. Turn on or restart the computer. If you are in Windows, click Start > Shut Down > Restart.

2. As soon as the computer is turned on, press and hold the F10 key until you enter Computer
Setup. Press Enter to bypass the title screen, if necessary.

If you do not press the F10 key at the appropriate time, you must turn the computer off, then on
again, and press the F10 key again to access the utility.

If you are using a PS/2 keyboard, you may see a Keyboard Error message—disregard it.

3. Select Security, then Power-On Password and follow the instructions on the screen.
4. Before exiting, click File > Save Changes and Exit.

34
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Entering a Power-On Password

To enter a power-on password, complete the following steps:
1. Turn on or restart the computer. If you arein Windows, click Start > Shut Down > Restart.
2. When the key icon appears on the monitor, type your current password, then press Enter.

|:| Type carefully; for security reasons, the characters you type do not appear on the screen.

If you enter the password incorrectly, abroken key icon appears. Try again. After three
unsuccessful tries, you must turn off the computer, then turn it on again before you can continue.
Entering a Setup Password

If a setup password has been established on the computer, you will be prompted to enter it each
time you run Computer Setup.

1. Turn on or restart the computer. If you are in Windows, click Start > Shut Down > Restart.

2. As soon as the computer is turned on, press and hold the F10 key until you enter Computer
Setup. Press Enter to bypass the title screen, if necessary.

|:| If you do not press the F10 key at the appropriate time, you must turn the computer off, then on
again, and press the F10 key again to access the utility.

If you are using a PS/2 keyboard, you may see a Keyboard Error message—disregard it.

3. When the key icon appears on the monitor, type the setup password, then press the Enter
key.

|:| Type carefully; for security reasons, the characters you type do not appear on the screen.

If you enter the password incorrectly, a broken key icon appears. Try again. After three
unsuccessful tries, you must turn off the computer, then turn it on again before you can continue.
Changing a Power-On or Setup Password

1. Turn on or restart the computer. If you arein Windows, click Start > Shut Down > Restart.
To change the setup password, run Computer Setup.

2. To change the Power-On password, go to step 3.

To change the Setup password, as soon as the computer is turned on, press and hold the F10
key until you enter Computer Setup. Press Enter to bypass the title screen, if necessary.

|:| If you do not press the F10 key at the appropriate time, you must turn the computer off, then on
again, and press the F10 key again to access the utility.

If you are using a PS/2 keyboard, you may see a Keyboard Error message—disregard it.
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3. When the key icon appears, type your current password, a slash (/) or aternate delimiter
character, your new password, another slash (/) or alternate delimiter character, and your
new password again as shown:
current password/new password/new password

Type carefully; for security reasons, the characters you type do not appear on the screen.

4. Pressthe Enter key.
The new password takes effect the next time you turn on the computer.

Refer to the “National Keyboard Delimiter Characters’ section in this chapter for information
about the alternate delimiter characters.

The power-on password and setup password may also be changed using the Security optionsin
Computer Setup.

Deleting a Power-On or Setup Password

1. Turn on or restart the computer. If you arein Windows, click Start > Shut Down > Restart.
To delete the setup password, run Computer Setup.

2. To delete the Power-On password, go to step 3.

To delete the Setup password, as soon as the computer is turned on, press and hold the F10
key until you enter Computer Setup. Press Enter to bypass the title screen, if necessary.

If you do not press the F10 key at the appropriate time, you must turn the computer off, then on
again, and press the F10 key again to access the utility.

If you are using a PS/2 keyboard, you may see a Keyboard Error message—disregard it.

3. When the key icon appears, type your current password followed by aslash (/) or aternate
delimiter character as shown:
current password/

4. Press the Enter key.

Refer to “National Keyboard Delimiter Characters’ for information about the alternate delimiter
characters. The power-on password and setup password may also be changed using the Security
optionsin Computer Setup.

3-6

359782-002 Service Reference Guide, dx2000 uT



Desktop Management

National Keyboard Delimiter Characters

Each keyboard is designed to meet country-specific requirements. The syntax and keys that you

use for changing or deleting your password depend on the keyboard that came with your

compuiter.
National Keyboard Delimiter Characters

Arabic Greek Russian /
Belgian Hebrew Slovakian
BHCSY* Hungarian Spanish
Brazilian ltalian Swedish/Finnish /
Chinese Japanese Swiss
Czech Korean Taiwanese /
Danish Latin American Thai /
French Norwegian Turkish .
French Canadian Polish U.K. English /
German Portuguese U.S. English /

* For Bosnia-Herzegovina, Croatia, Slovenia, and Yugoslavia

Clearing Passwords

If you forget your password, you cannot access the computer. To clear the password, turn off and
unplug the computer then, press the CMOS reset button, holding it down for 5 seconds. Close

and restart the computer.

3.3.4 Surge-Tolerant Power Supply

An integrated surge-tolerant power supply provides greater reliability when the computer is hit
with an unpredictable power surge. This power supply is rated to withstand a power surge of up
to 2000 volts without incurring any system downtime or data loss.
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4.1

4.2

4.2.1

[]

Ultra ATA Drive Guidelines and Features

Ultra ATA Jumpers

Ultra ATA drives are configured by means of jumper settings. Factory-installed drives ship with
the jumpers preset to the cable-select mode; therefore, no jumper setting changes are required on
factory preinstalled, replacement, or option drives. With cable-select, the drive is configured as
either Master (Drive/Device 0) or Slave (Drive/Device 1) by its physical attachment to the cable.

If you purchase a third-party hard drive, refer to the documentation included with the drive kit to
ensure proper cable installation and configuration.

All drives on a controller channel need to have their jumpers either in the cable-select mode or
have the individual drive jumper installed on the appropriate Master (Drive/Device 0) or Slave
(Drive/Device 1) position.

Ultra ATA Cables

When installing a second device on either the primary or secondary controller, you must use an
industry standard 40-pin, 80-conductor Ultra ATA cable for optimal performance. These cables
have a maximum length of 18 inches and a maximum distance of 6 inches between the two
devices for atwo-drive cable.

Drives operating at speeds faster than those of the Ultra ATA-33 devices require industry-
standard 40-pin, 80-conductor cablesto maintain the higher data transfer rates possible with the
improved technology.

When using Ultra ATA-133, -100, -66, and slower -33 drives in the same system, each drive will
operate at its appropriate data transfer rate.

Cable Layout

The faces of industry-standard cable connectors are color coded for easy recognition:
m  System board connector = blue face

m  Device 0 connector = black face

m  Device 1 connector = gray face

The color code of an industry-standard cableisvalid only if the drive's jumper isin the cable-
select position.
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Single-Drive Cable

System DeviceO
Board (master)
o
I T
Blue Black
Face Face
Two-Drive Cable
System Devicel DeviceO
Board (slave) (master)
L or
T T h
Blue Gray Black
Face Face Face

On atwo-drive cable, the Drive/Device 0 connector is always the farthest one from the system
board connector and the Drive/Device 1 connector is always the closest to the system board
connector.

|:| Some cables may be labeled “Drive 0" instead of “Device 0" and “Drive 1” instead of
“Device1”.

4.3 Drive Installation Guidelines

Most computer system boards have two ATA (IDE) controller channels with a dedicated
connector for each controller. One controller is designated as the primary and the other as the
secondary controller.

Each of the two controllers can have up to two devices attached to it. Each computer system may
therefore have a maximum of four ATA/ATAPI drives. All drives are connected to these
controllers using an industry-standard 40-pin, 80-conductor cable.

|:| Theindustry standard 1.44 MB diskette drive has its own separate channel and is not included as
apart of the maximum four drives.

Any drive attached to a controller must have a drive designation. If only asingle driveis
connected to a controller and its jumper isin the cable-select position, it is designated as the
Master Drive (Drive/Device 0) by its attachment to the Drive/Device O cable position. If two
cable-selected drives are connected to a single controller, one will be designated by its
attachment to the cable as the Master (Drive/Device 0) and the other as Slave (Drive/Device 1).

For optimal performance of a computer system, all drives need to be attached to the ATA
controllersin a specified sequence. This sequence is determined by the device class of the drives
and by specific attach sequence rules.
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4.3.1 Device Classes

In order to determine the best drive attach sequence, ATA/ATAPI drives are segregated into four
different classes based upon the bandwidth demands they place on an ATA controller. The most
demanding devices are in Class 1 and the least demanding arein Class 4.

Class 1 Class 2 Class 3 Class 4
Hard High Speed Optical Storage Magnetic
Drives Optical Drives Drives Storage Drives

ATA-100 DVD R/W CD-ROM LS-120
ATA-66 DVD-CD R/W CD-ROM Tape
ATA-33 Zip

General Attach Guidelines

m  Thelower the device class number, the faster the device and the more bandwidth required.

m  Drivesinstalled in the Device 0 positions on both the primary and secondary controllers
receive the greatest possible bandwidth.

m  The bootable ATA hard drive should always be installed on the primary controller in the
Device 0 position.

4.3.2 Attach Sequence Rules by Class Priority

Drives should be attached in the sequence shown for optimum performance starting at

position @.
(4) (1)
(3] (2]
T
Primary (4] 1]
Controller*
T o
I N Y
Secondary (3] (2]
Controller
o . 7
Device 1 Device 0

*|f there are three or more devices, two or more of which are hard drives, two hard drives should
be attached to the primary controller first before following the General Attach Sequence Rule.
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The attach sequence rule may also be stated in table format:

General Attach Sequence Rule*

Sequence Description
1 The lowest class drive - bootable hard drive recommended.
2 If only two drives, the last drive goes here; otherwise the lowest class of the

remaining drives.

3 If only three drives, attach the final drive here. If a fourth drive exists, attach the
lowest class drive here.

4 If there is a fourth drive, attach the final drive here - the drive with the highest
class number of all devices.

*|f there are three or more devices, two or more of which are hard drives, two hard drives
should be attached to the primary controller first before following the General Attach Sequence
Rule.

Therulesalow for:

m  Keeping the hard drive on a separate controller channel maximizes drive performance until a
fourth device is added.

m  Keeping the hard drives and removable media drives on separate controller channels
maximizes compatibility.

m  Keeping the hard drive and the writable optical drive on separate controller channels
maximizes optical drive reliability.

4.3.3 Attach Sequence Worksheet

Use the worksheet below for abtaining optimum system performance when setting up a computer
with multiple drives. Use the General Attach Sequence Rule to determine the best drive
installation sequence.

Attach Sequence Worksheet

Position Controller Device
Device Name Device Class Number Name Number

Two examples of how to use the worksheet are:
m  Threedeviceinstalation
m  Four deviceinstallation
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Example 1: Three Device Installation Sample

A system has three devices: Ultra ATA-100 hard drive, CD-ROM drive, and aDVD drive. Using
the Device Class Table in Section 4.3.1, the devices may be identified as:

m  Ultra ATA-100 hard drive = Class 1
m DVD drive=Class 2
m  CD-ROM drive=Class3

Attach Sequence Worksheet - Three Device Installation (Sample)

Device Position Controller Device
Device Name Class Number Name Number
Ultra ATA-100 hard drive 1 o Primary 0
DVD drive 2 (2] Secondary 0
CD-ROM drive 3 (3] Secondary 1
(4) (1]
(3] (2]
Primary (4] (1]
Controller*
Or
- & -
Secondary (3] (2]
Controller
5 - .
Device 1 Device O

Example 2: Four Device Installation Sample

A system has four devices: Ultra ATA-100 hard drive, Ultra ATA-100 hard drive, DVD-CDR/W

drive, and a ZIP-250 drive. Using the Device Class Table in Section 4.3.1, the devices may be
reidentified as:

m  UltraATA-100 hard drive = Class 1
m  UltraATA-100 hard drive = Class 1
m DVD-CDR/W drive = Class 2

m  ZIP-250 drive = Class 4

Service Reference Guide, dx2000 uT 359782-002 4-5



Ultra ATA Drive Guidelines and Features

Attach Sequence Worksheet - Four

Device Installation (Sample)

Device Position Controller Device
Device Name Class Number Name Number
Ultra ATA-100 hard drive 1 o Primary 0
DVD-CDR/W drive 2 (2] Secondary 0
ZIP-250 drive 4 (3] Secondary 1
Ultra ATA-100 hard 1 (4] Primary 1
drive*

*|f there are three or more devices, two or more of which are hard drives, two hard drives should
be attached to the primary controller first before following the General Attach Sequence Rule.

(4) (1)
(3) (2]
Primary (4] (1]
Controller*
r
. 7 ?
Secondary (3] (2]
Controller
O = =
Device 1 Device O

4.3.4 Additional Drive Application Notes

4.4

m  When replacing a hard drive, the replacement should be of the same type (Ultra ATA -33, -
66, or -100) as that being removed to retain the same level of performance.

m  When Ultra ATA and SCSI hard drives are mixed

in the same system, the Ultra ATA drive

will become the boot drive unless the boot order is changed in Computer Setup (F10 Setup).

SMART

The Self Monitoring Analysis and Recording Technology (SMART) ATA drives for the HP
Personal Computers have built-in drive failure prediction that warns the user or network
administrator of an impending failure or crash of the hard drive. The SMART drive tracks fault
prediction and failure indication parameters such as reallocated sector count, spin retry count,
and calibration retry count. If the drive determines that afailure isimminent, it generates a fault

dert.
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4.5 Drive Capacities

The combination of the file system and the operating system used in the computer determinesthe
maximum usable size of adrive partition. A drive partition is the largest segment of a drive that
may be properly accessed by the operating system. A single hard drive may therefore be
subdivided into a number of unique drive partitionsin order to make use of al of its space.

The table that follows identifies the capabilities and restrictions imposed on the computer by the
combinations of file and operating systems.

Microsoft to Drive Manufacturer Size Conversion Table*

Drive Size as Identified by Microsoft Drive Size as Identified by
Operating System Drive Manufacturers

2 GB 2.1 GB

4 GB 4.3 GB

32 GB 34.4 GB

64 GB 68.7 GB

128 GB 137 GB
2TB 2.199 TB

*Drive size calculations by drive manufacturers are bytes to the base 10 while calculations by
Microsoft are bytes to the base 2.

Drive/Partition Capacity Limits

Maximum Size

File Controller
System Type Operating System Partition Drive
FAT 32 ATA Windows 2000/ XP 32 GB 128 PB
FAT 32 SCSl Windows 2000/ XP 32 GB 2TB
NTFS ATA Windows NT/2000/XP 128 TB 128 PB
NTFS SCSI Windows NT/2000/XP 2TB 2TB
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Identifying the Chassis, Routine Care, and
Disassembly Preparation

This chapter provides genera serviceinformation for the computer. Adherence to the procedures
and precautions described in this chapter is essential for proper service.

CAUTION: When the computer is plugged info an AC power source voltage is always applied to the
system board. You must disconnect the power cord from the power source before opening the computer
to prevent system board or component damage.

5.1 Chassis Designations

5.1.1 Microtower (uT)

This chassis may have either a carbonite or silver front bezel depending on the geographical
location.
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5.2

5.2.1

[]

Electrostatic Discharge Information

A sudden discharge of static electricity from your finger or other conductor can destroy static-
sensitive devices or microcircuitry. Often the spark is neither felt nor heard, but damage occurs.
An electronic device exposed to electrostatic discharge (ESD) may not appear to be affected at
al and can work perfectly throughout a normal cycle. The device may function normally for a
while, but it has been degraded in the internal layers, reducing its life expectancy.

Networks built into many integrated circuits provide some protection, but in many cases, the
discharge contains enough power to alter device parameters or melt silicon junctions.
Generating Static

The following table shows that:
m Different activities generate different amounts of static electricity.
m  Static electricity increases as humidity decreases.

Relative Humidity

Event 55% 40% 10%
Walking across carpet 7,500V 15,000 V 35,000 V
Walking across vinyl floor 3,000V 5,000 V 12,000 V
Motions of bench worker 400V 800V 6,000 vV
Removing bubble pack from PCB 7,000 V 20,000 V 26,500 V
Packing PCBs in foam-lined box 5,000 V 11,000 V 21,000 V

700 volts can degrade a product.

5.2.2 Preventing Electrostatic Damage to Equipment

Many electronic components are sensitive to ESD. Circuitry design and structure determine the
degree of sensitivity. The following packaging and grounding precautions are necessary to
prevent damage to electric components and accessories.

m To avoid hand contact, transport products in static-safe containers such as tubes, bags, or
boxes.

m  Protect all electrostatic parts and assemblies with conductive or approved containers or
packaging.

m  Keep electrostatic sensitive parts in their containers until they arrive at static-free stations.

m  Placeitems on agrounded surface before removing them from their container.

m  Always be properly grounded when touching a sensitive component or assembly.

m  Avoid contact with pins, leads, or circuitry.

m  Place reusable el ectrostatic-sensitive parts from assemblies in protective packaging or
conductive foam.

5-2
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5.2.3 Personal Grounding Methods and Equipment

Use the following equipment to prevent static electricity damage to equipment:

m  Wrist straps are flexible straps with a maximum of one-megohm + 10% resistance in the
ground cords. To provide proper ground, a strap must be worn snug against bare skin. The
ground cord must be connected and fit snugly into the banana plug connector on the
grounding mat or workstation.

m  Heel straps/Toe straps/Boot straps can be used at standing workstations and are
compatible with most types of shoes or boots. On conductive floors or dissipative floor mats,
use them on both feet with a maximum of one-megohm * 10% resistance between the
operator and ground.

Static Shielding Protection Levels

Method Voltage
Antistatic plastic 1,500
Carbon-loaded plastic 7,500
Metallized laminate 15,000

5.2.4 Grounding the Work Area

To prevent static damage at the work area, use the following precautions:

m  Cover the work surface with approved static-dissipative material. Provide awrist strap
connected to the work surface and properly grounded tools and equipment.

m  Use static-dissipative mats, foot straps, or air ionizers to give added protection.

m  Handle electrostatic sensitive components, parts, and assemblies by the case or PCB
laminate. Handle them only at static-free work areas.

m  Turn off power and input signals before inserting and removing connectors or test
equipment.

m  Usefixtures made of static-safe materials when fixtures must directly contact dissipative
surfaces.

m  Keep work areafree of nonconductive materials such as ordinary plastic assembly aids and
Styrofoam.

m  Usefield service tools, such as cutters, screwdrivers, and vacuums, that are conductive.

5.2.5 Recommended Materials and Equipment

Materials and equipment that are recommended for use in preventing static electricity include:
m  Antistatic tape

m  Antistatic smocks, aprons, or sleeve protectors

m  Conductive bins and other assembly or soldering aids

m  Conductive foam

m  Conductive tabletop workstations with ground cord of one-megohm +/- 10% resistance

m  Static-dissipative table or floor mats with hard tie to ground

m  Field servicekits
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5.3

m  Static awareness labels

m  Wrist straps and footwear straps providing one-megohm +/- 10% resistance
m  Material handling packages

m  Conductive plastic bags

m  Conductive plastic tubes

m  Conductive tote boxes

m  Opague shielding bags

m  Transparent metallized shielding bags

m  Transparent shielding tubes

Routine Care

5.3.1 General Cleaning Safety Precautions

1. Never use solvents or flammable solutions to clean the compuiter.

2. Never immerse any partsin water or cleaning solutions; apply any liquidsto a clean cloth
and then use the cloth on the component.

3. Always unplug the computer when cleaning with liquids or damp cloths.

4. Always unplug the computer before cleaning the keyboard, mouse, or air vents.
5. Disconnect the keyboard before cleaning it.

6. Wear safety glasses equipped with side shields when cleaning the keyboard.

5.3.2 Cleaning the Computer Case

Follow all safety precautionsin Section 5.3.1, “ General Cleaning Safety Precautions,” before
cleaning the compuiter.

To clean the computer case, follow the procedures described below:
m  Toremove light stains or dirt, use plain water with a clean, lint-free cloth or swab.

m  For stronger stains, use amild dishwashing liquid diluted with water. Rinse well by wiping it
with acloth or swab dampened with clear water.

m  For stubborn stains, use isopropyl (rubbing) alcohol. No rinsing is needed as the alcohol will
evaporate quickly and not leave aresidue.

m  After cleaning, always wipe the unit with a clean, lint-free cloth.

m  Occasionally clean the air vents on the computer. Lint and other foreign matter can block the
vents and limit the airflow.
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5.3.3 Cleaning the Keyboard

Follow all safety precautionsin Section 5.3.1, “ General Cleaning Safety Precautions,” before
cleaning the keyboard.

To clean the tops of the keys or the keyboard body, follow the procedures described in Section
5.3.2, “Cleaning the Computer Case.”

When cleaning debris from under the keys, review al rulesin Section 5.3.1, “General Cleaning
Safety Precautions,” before following these procedures:

CAUTION: Use safety glasses equipped with side shields before attempting to clean debris from under
the keys.

Visible debris underneath or between the keys may be removed by vacuuming or shaking.

Canned, pressurized air may be used to clean debris from under the keys. Caution should be
used as too much air pressure can dislodge lubricants applied under the wide keys.

If you remove a key, use a specially designed key puller to prevent damage to the keys. This
tool is available through many electronic supply outlets.

CAUTION: Never remove a wide leveled key (like the space bar) from the keyboard. If these keys are
improperly removed or installed, the keyboard may not function properly.

Cleaning under akey may be done with a swab moistened with isopropyl acohol and
squeezed out. Be careful not to wipe away |ubricants necessary for proper key functions. Use
tweezers to remove any fibers or dirt in confined areas. Allow the partsto air dry before
reassembly.

5.3.4 Cleaning the Monitor

Wipe the monitor screen with a clean cloth moistened with water or with atowelette
designed for cleaning monitors. Do not use sprays or aerosols directly on the screen; the
liguid may seep into the housing and damage a component. Never use solvents or flammable
ligquids on the monitor.

To clean the monitor body follow the proceduresin Section 5.3.2, “ Cleaning the Computer
Case”

5.3.5 Cleaning the Mouse

Before cleaning the mouse, ensure that the power to the computer is turned off.

Clean the mouse ball by first removing the retaining plate and the ball from the housing. Pull
out any debris from the ball socket and wipe the ball with a clean, dry cloth before
reassembly.

To clean the mouse body, follow the procedures in Section 5.3.2, “ Cleaning the Computer
Case”
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5.4 Service Considerations

Listed below are some of the considerations that you should keep in mind during the disassembly
and assembly of the compuiter.

5.4.1 Power Supply Fan
The power supply fan is a variable-speed fan based on the temperature in the power supply.

CAUTION: The cooling fan is off only when the computer is turned off or the power cable has been
disconnected.

The cooling fan is always on when the computer is either in the “On,” “Standby,” or “Suspend” modes.

You must disconnect the power cord from the power source before opening the computer to prevent
system board or component damage.

5.4.2 Tools and Software Requirements

To service the computer, you need the following:

m  Torx T-15 screwdriver (Compag screwdriver with bits, PN 161946-001)

m  Torx T-15 screwdriver with small diameter shank (for certain front bezel removal)
m  Flat-bladed screwdriver (may sometimes be used in place of the Torx screwdriver)
m  Diagnostics software

m  Compag tamper-resistant T-15 wrench (Smart Cover FailSafe Key, PN 166527-001) or
Compag tamper-resistant bits (Smart Cover Fail Safe Key, PN 166527-002)

5.4.3 Screws

The screws used in the computer are not interchangeable. They may have standard or metric
threads and may be of different lengths. If an incorrect screw is used during the reassembly
process, it can damage the unit. HP strongly recommends that all screws removed during
disassembly be kept with the part that was removed, then returned to their proper locations.

|:| Metric screws have a black finish.
U.S. screws have a silver finish.

|:| As each subassembly is removed from the computer, it should be placed away from the work
areato prevent damage.
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5.4.4

5.4.5

Cables and Connectors

Most cables used throughout the unit are flat, flexible cables. These cables must be handled with
care to avoid damage. Apply only the tension required to seat or unseat the cables during
insertion or removal from the connector. Handle cables by the connector whenever possible. In
all cases, avoid bending or twisting the cables, and ensure that the cables are routed in such away
that they cannot be caught or snagged by parts being removed or replaced.

CAUTION: When servicing this computer, ensure that cables are placed in their proper location during
the reassembly process. Improper cable placement can damage the computer.

Hard Drives

Handle hard drives as delicate, precision components, avoiding al physical shock and vibration.
This appliesto failed drives as well as replacement spares.

m If adrive must be mailed, place the drive in a bubble-pack mailer or other suitable protective
packaging and |abel the package “ Fragile: Handle With Care”

m Do not remove hard drives from the shipping package for storage. Keep hard drivesin their
protective packaging until they are actually mounted in the CPU.

= Avoid dropping drives from any height onto any surface.

m |f you areinserting or removing a hard drive, turn off the computer. Do not remove a hard
drive while the computer is on or in standby mode.

m  Before handling adrive, ensure that you are discharged of static electricity. While handling a
drive, avoid touching the connector. For more information about preventing el ectrostatic
damage, refer to Section 5.2, “Electrostatic Discharge Information.”

m Do not use excessive force when inserting adrive.

m  Avoid exposing a hard drive to liquids, temperature extremes, or products that have
magnetic fields such as monitors or speakers.

5.4.6 Lithium Coin Cell Battery

A\

The battery that comes with the computer provides power to the real-time clock and has a
minimum lifetime of about three years.

See the appropriate removal and replacement chapter for the chassis you are working on in this
guide for instructions on the replacement procedures.

WARNING: This computer contains a lithium battery. There is a risk of fire and chemical burn if the
battery is handled improperly. Do not disassemble, crush, puncture, short external contacts, dispose in
water or fire, or expose it to temperatures higher than 140°F (60°C).

CAUTION: Batteries, battery packs, and accumulators should not be disposed of together with the
general household waste.
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Removal and Replacement Procedures—
icrotower (uT) Chassis

Adherence to the procedures and precautions described in this chapter is essential for proper
service. After completing all necessary removal and replacement procedures, run the Diagnostics
utility to verify that all components operate properly.

|:| Not all features listed in this guide are available on all computers.

6.1 Preparation for Disassembly

See Chapter 5, “Identifying the Chassis, Routine Care, and Disassembly Preparation,” for initial
procedures.

1. Close any open software applications.

2. Exit the operating system.

3. Remove any diskette or compact disc from the computer.

4. Turn off the computer and any peripheral devicesthat are connected to it.

fi CAUTION: Turn off the computer before disconnecting any cables.

CAUTION: Regardless of the power-on state, voltage is always present on the system board as long as
the system is plugged into an active AC outlet. In some systems the cooling fan is on even when the
computer is in the “Standby,” or “Suspend” modes. The power cord should always be disconnected
before servicing a unit.

5. Disconnect the power cord from the electrical outlet and then from the computer.
6. Disconnect all peripheral device cables from the computer.

|:| During disassembly, label each cable as you remove it, noting its position and routing. Keep all
screws with the units removed.

CAUTION: The screws used in the computer are of different thread sizes and lengths; using the wrong
screw in an application may damage the unit.
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6.2 Access Panel
1. Prepare the computer for disassembly (Section 6.1, “Preparation for Disassembly”).

CAUTION: Before removing the computer access panel, ensure that the computer is turned off and that
the power cord is disconnected from the electrical outlet.

2. Remove the two screws that secure the access panel to the computer chassis. Some access
panels use captive thumbscrews.

|:| Remove the right access panel to upgrade memory or an expansion card.

Remove the |eft access panel to upgrade a drive.

3. Slide the access panel back about 1 inch (2.5 cm), then lift it away from and off the unit.

-
-
« -~
,
l &

To replace the access panel, reverse the removal steps.

|:| The two access panels are physically identical. One access panel has captive thumbscrews that
may be removed by unscrewing them.
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6.3 Front Bezel

1. Prepare the computer for disassembly (Section 6.1, “Preparation for Disassembly”).
2. Remove the access panels (Section 6.2, “Access Pandl”).

3. Grasp the bottom of the front panel below the lowest air vent and pull the panel out and up to
release it from the chassis.

To install the front bezel, insert the top two latches into their respective holes in the chassis and
push the bezel in until it isfully seated.

|:| When replacing the front bezel, ensure that the top of the front bezel is flush with the top of the
chassis before pressing it into place.
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6.4 Front Drive Bezels

1. Prepare the computer for disassembly (Section 6.1, “Preparation for Disassembly”).
2. Remove the access panel (Section 6.3, “Front Bezel”).
3. Remove the front bezel (Section 6.3, “Front Bezel”).

6.4.1 5.25" Drive Bezel Blank

Press one of the retaining tabs on the inside of the large bezel towards the outer edge of the bezel
to release the bezel blank. At the sametime, pull the bezel blank inwards to remove it from the
main bezel.

To install abezel blank, reverse the removal procedure.
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6.4.2 Diskette Drive Bezel

Pull the right retaining tab towards the center of the main bezel. At the sametime, pull the bezel
inwards to remove it from the main bezel.

To install a diskette drive bezel, reverse the removal procedure.
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6.5 Memory

For more information on the memory in this series of computers, refer to Appendix E,
“Memory.”

6.5.1 Installing Memory Modules

CAUTION: The memory module sockets have gold metal contacts. When upgrading the memory, it is
important fo use memory modules with gold metal contacts to prevent corrosion and/or oxidation
resulting from having incompatible metals in contact with each other.

CAUTION: Static electricity can damage the electronic components of the computer or optional cards.
Before beginning these procedures, ensure that you are discharged of static electricity by briefly
touching a grounded metal object. Refer to Chapter 5 for more information.

CAUTION: When handling a memory module, be careful not to touch any of the contacts. Doing so
may damage the module.

1. Prepare the computer for disassembly (Section 6.1, “Preparation for Disassembly”).

|:| If thereisahard drive in bay 5 it will be necessary to remove the lower drive cage before
removing the memory modules (Section 6.7.4, “Removing the Lower Drive Cage”).

2. Remove the right access panel (Section 6.2, “Access Panel™).

WARNING: To reduce risk of personal injury from hot surfaces, allow the internal system components
to cool before touching.

3. Lay the computer down on its side to make it easier to work on.

4. Open both latches of the memory module socket @, and insert the memory module into the
socket @. Begin by installing a module into the socket nearest the preinstalled module, and
install the modules following the numerical order of the sockets.
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[]

A memory module can be installed in only one way. Match the notch on the modul e with the tab
on the memory socket.

5. Push the module down into the socket, ensuring that the module is fully inserted and
properly seated. Make sure the latches are in the closed position ©.

6. Repeat steps 4 and 5 for any additional modul es that you want to install.
To reassembl e the computer, reverse the removal procedure.
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6.6 Expansion Card

1. Prepare the computer for disassembly (Section 6.1, “Preparation for Disassembly”).
2. Remove the right access panel (Section 6.2, “Access Panel”).
3. Lay the computer down on its side to make it easier to work on.

If installing an expansion card in an empty slot, skip to step 9.
4. To remove an expansion card, disconnect any cables attached to the expansion card.
5. Remove the screw at the top of the expansion slot.

6. Hold the card at each end and carefully rock it back and forth until the connectors pull free
from the socket. Be sure not to scrape the card against other components.

7. Store the card in anti-static packaging.

8. Install a new expansion card or an expansion slot cover to close the open slot.
If not installing an additional expansion card, skip to step 11.

9. Remove the expansion slot cover.

10. Slide the expansion card into the expansion socket and press it firmly into place.

|:| When you install an expansion card, make sure you press firmly on the card so that the entire
connector seats properly in the expansion card socket.

11. Install the screw at the top of the expansion slot to further secure the part in the chassis.
12. Replace the access panel.

13. Connect external cablesto the installed card, if needed.

Reconfigure the compuiter, if necessary.
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6.7 Drives

The computer supports up to five drives that may be installed in various configurations.

This Section describes the procedure for replacing or upgrading the storage drives. A Torx T-15
screwdriver is needed to remove and install the guide screws on adrive.

CAUTION: Make sure personal files on the hard drive are backed up to an external storage device
before removing the hard drive. Failure to do so will result in data loss. After replacing the primary hard
drive, you will need to run the Restore Plus! CD to load the Compaq factory-installed files.

6.7.1 Drive Positions

Drive Positions

Item Description Item Description

o Optical drive (4] Hard drive

(2] Optical drive (5] Hard drive

(3] Diskette drive

(’;An optical drive is a CD-ROM, CD-R/RW, DVD-ROM, DVD-R/RW, or CD-RW/DVD Combo
rive.
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6.7.2 Removing a 5.25" Drive

1. Prepare the computer for disassembly (Section 6.1, “Preparation for Disassembly”).
2. Remove both the right and left access panels (Section 6.2, “Access Panel”).

3. Remove the front bezel (Section 6.3, “Front Bezel”).

4. Disconnect the power, data, and audio cables, as necessary, from the back of the drive.

|:| In some cases it may be easier to side the drive part way out of the drive bay before removing
the cables.

5. Remove the four screws, two from each side, that secure the drive in the drive cage @.
6. Slide the drive out of the drive cage, as shown in theillustration below @.

To install adrive, reverse the removal procedure.

|:| If you areinstalling a5.25" drive for thefirst time into bay 2 you must first remove the drive
from bay 1 and then knock or pry out the metal shield that covers the front of bay 2.

WARNING: There may be sharp edges on the inside of the bay opening after the shield has been
removed.
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6.7.3 Removing a Diskette Drive

1. Prepare the computer for disassembly (Section 6.1, “Preparation for Disassembly”).
2. Remove both the right and left access panels (Section 6.2, “Access Panel”).

3. Remove the front bezel (Section 6.3, “Front Bezel”).

4. Disconnect the power, and data cables from the back of the drive.

5. Remove the four screws, two from each side, that secure the drive in the drive cage @.
6. Slide the drive out of the front of the chassis @®.

To replace the diskette drive, reverse removal procedure.
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6.7.4 Removing the Lower Drive Cage

1. Prepare the computer for disassembly (Section 6.1, “Preparation for Disassembly”).
. Remove both the right and | eft access panels (Section 6.2, “Access Panel”).

. Remove the front bezel (Section 6.3, “Front Bezel”).

. Remove the diskette drive (Section 6.7.3, “Removing a Diskette Drive").

. Disconnect the power, and data cables from the back of all installed 3.5" drives.

. Remove the four screws that secure the drive cage to the front of the chassis @ and then
remove the single screw that attaches the lower drive cage to the fixed upper drive cage on
the right side of the chassis ®.

o O~ WD

7. Slide the lower drive cage back about 1/2 inch to release it from the upper cage ©.

To install the lower drive cage, reverse the removal procedure.

fi CAUTION: When installing the retaining screws always use the short (5/32" long) screw in the side
mounting position and the 4 longer screws on the front of the chassis.
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6.7.5 Removing a 3.5" Hard Drive

. Prepare the computer for disassembly (Section 6.1, “ Preparation for Disassembly”).

. Remove both the right and | eft access panels (Section 6.2, “Access Panel”).

. Remove the front bezel (Section 6.3, “Front Bezel”).

. Remove the diskette drive (Section 6.7.3, “Removing a Diskette Drive").

. Disconnect the power, and data cables from the back of all installed 3.5" drives.

. Remove the lower drive cage (Section 6.7.4, “Removing the Lower Drive Cage”).

. Remove the four screws, two from each side, that secure the drive in the drive cage @.

0 N O O~ WD P

. Slide the drive out of the drive cage ®.

—y

e
g

o
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To replace the drive cage, reverse the removal procedure.
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6.8 Front USB Device

1. Prepare the computer for disassembly (Section 6.1, “Preparation for Disassembly”).
2. Remove the right access panel (Section 6.2, “Access Panel™).

3. Remove the front bezel (Section 6.3, “Front Bezel”).

4. Disconnect the front USB cable from the system board.

5. Remove the single screw that secures the front USB device to the chassis @, then dide the
USB housing up to release it from the chassis @.

6. Remove the two screws that secure the USB printed circuit board from the inside of the USB
housing and then remove the board.

To install the USB board and the USB housing to the chassis, reverse the removal procedures.
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6.9 Power Switch Assembly

. Prepare the computer for disassembly (Section 6.1, “Preparation for Disassembly”).
. Remove the right access panel (Section 6.2, “Access Panel”).

. Remove the front bezel (Section 6.3, “Front Bezel”).

. Remove the diskette drive (Section 6.7.3, “Removing a Diskette Drive’).

. Disconnect the power, and data cables from the back of all installed 3.5" drives.

. Remove the lower drive cage (Section 6.7.4, “Removing the Lower Drive Cage”).

. Disconnect the power switch cable from the system board.

o N o 0o~ WDN PP

. From the inside of the chassis, squeeze the two lower retaining clips together @ while
rotating the bottom of the power switch out of the chassis @.

To install the power switch assembly, reverse the removal procedure.
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6.10 Speaker

1. Prepare the computer for disassembly (Section 6.1, “Preparation for Disassembly”).
2. Remove the right access panel (Section 6.2, “Access Panel”).

3. Remove the front bezel (Section 6.3, “Front Bezel”).

4. Disconnect the speaker cable from the system board @.

5. From the outside of the chassis pull out the stems of the four push pins to release the
speakers then, remove the speaker @.

g
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To install the speaker, reverse the removal procedure. To ensure proper alignment, install the
push pinsin an X pattern.
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6.11 System Fan

1. Prepare the computer for disassembly (Section 6.1, “Preparation for Disassembly”).
2. Remove the right access panel (Section 6.2, “Access Panel”).

3. Disconnect the cable that connects the system fan to the system board.

4. Remove the four screws that secure the fan to the chassis and remove the fan.

To install the fan, reverse the removal procedures.
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6.12 Processor and Heatsink

1. Prepare the computer for disassembly (Section 6.1, “Preparation for Disassembly”).
2. Remove the right access panels (Section 6.2, “Access Panel”).

3. Lay the computer down on its side to make it easier to work on.

4. Use along, slender screwdriver to unscrew the four processor retaining screws @.

|:| The spring-loaded retaining screws are captive to the heatsink.

5. Twist the heatsink to break the bond between it and the processor and lift the heatsink from
the processor @.

6. Raise the handle on the ZIF socket to the full-open position ©.
7. Grasp the processor by the edges and pull it straight up from the socket ®.

To install the processor and heatsink, reverse the removal procedures.

CAUTION: When installing the heatsink, insert all four screw loosely and then tighten them in a X
pattern to ensure the heatsink is properly seated.
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6.13 System Board

1. Prepare the computer for disassembly (Section 6.1, “Preparation for Disassembly”).
2. Remove both the right and |eft access panels (Section 6.2, “Access Panel”).

3. Remove the front bezel (Section 6.3, “Front Bezel”).

4. Remove the diskette drive (Section 6.7.3, “Removing a Diskette Drive”).

5. Disconnect the power, and data cables from the back of all installed 3.5" drives.

6. Remove the lower drive cage (Section 6.7.4, “Removing the Lower Drive Cage”).

|:| It is not necessary to remove the chassis fan from the chassis.

7. Disconnect all cables from the system board.
8. Remove the heatsink from the system board (Section 6.12, “ Processor and Heatsink”).
9. Remove the 8 screws that secure the system board to the chassis @.

10. Slide the system board towards the front of the chassis ® to remove it.

|:| The system board in the computer may ook slightly different from the one shown here.
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=
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To install the system board, reverse the removal procedure.
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6.14 Battery

The battery that comes with your computer provides power to the real-time clock and has a
lifetime of about three years. When replacing the battery, use a battery equivalent to the battery
originally installed on the computer. The computer comes with a 3-volt lithium coin cell battery.

Thelifetime of the lithium battery can be extended by plugging the computer into alive AC wall
socket. The lithium battery is only used when the computer is NOT connected to AC power.

WARNING: This computer contains an infernal lithium manganese dioxide battery. There is a risk of fire and
burns if the battery is not handled properly. To reduce the risk of personal injury:

® Do not attempt to recharge the battery.

B Do not expose to temperatures higher than 140°F (60°C)

m Do not disassemble, crush, puncture, short external contacts, or dispose of in fire or
water.

B Replace the battery only with the HP/Compaq spare designated for this product.

CAUTION: Before replacing the battery, it is important to back up the computer CMOS settings. When
the battery is removed or replaced, the CMOS settings will be cleared. Refer to the Troubleshooting
Guide for information on backing up the CMOS settings.

Batteries, battery packs, and accumulators should not be disposed of together with the general
household waste. In order to forward them to recycling or proper disposal, please use the public
collection system or return them to HP/Compag, their authorized partners, or their agents.

CAUTION: Static electricity can damage the electronic components of the computer or optional
equipment. Before beginning these procedures, ensure that you are discharged of static electricity by
briefly touching a grounded metal object.

1. Prepare the computer for disassembly (Section 6.1, “Preparation for Disassembly”).
2. Remove the right access panel (Section 6.2, “Access Panel™).

It may be necessary to remove an expansion card to gain access to the battery.

3. Locate the battery and battery holder on the system board.

6-20
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4. To release the battery from its holder, push away the metal clamp that extends above one
edge of the battery @. When the battery pops up, lift it out @.

5. Toinsert the new battery, slide one edge of the replacement battery in with the positive side
pointing to the metal retaining clamp as shown, until the clamp snaps over the other edge of
the battery.

|:| After the battery has been replaced, use the following steps to complete this procedure.

6. Replace the computer cover or access panel.
7. Plug in the computer and turn on power to the computer.
Reset the date and time, your passwords, and any specia system setups, using Computer Setup.
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6.15 Power Supply

WARNING: Voltage is always present on the system board when the computer is plugged into an
active AC outlet. To avoid possible personal injury and damage to the equipment the power cord should
be disconnected from the computer and/or the AC outlet before opening the computer.

1. Prepare the computer for disassembly (Section 6.1, “Preparation for Disassembly”).

2. Remove the right access panel (Section 6.2, “Access Panel™).

3. Disconnect al power cables from the mass storage devices and from the system board.

4. Remove the 4 screws @ that secure the power supply to the chassis.

5. Slide the power supply toward the front of the computer @, then lift it out of the computer.

To install the power supply, reverse the removal procedure.

|:| Itiseasier toinstall the power supply if the chassisis turned upside down. Thiswill give you
better control when supporting the power supply in the chassisto install the first retaining screw.
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Connector Pin Assignments

This appendix contains the pin assignments for many computer and workstation connectors.
Some of these connectors may not be used on the product being serviced.

Enhanced Keyboard
Connector and lcon Pin Signal

Data
Unused
Ground

+5 VDC
Clock
Unused

a0
oo
oo

i

Uk WON —

Mouse

Connector and lcon Pin Signal
Bpa
(B]u)

Ethernet RJ-45
Connector and Icon Pin Signal

Data
Unused
Ground

+5 VDC
Clock
Unused

A WON —

1 (+) Transmit Data
2 () Transmit Data
’:I B 3 (+) Receive Data
ﬁ 4 Unused
5 Unused
6 () Receive Data
7 Unused
8 Unused
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Connector Pin Assignments

Parallel Interface

Connector and Icon

\@@@@@@@O@@O/ m

(olojeleololoJololololo)C) [—\¢0
Pin Signal Pin Signal Pin Signal
1 Strobe 7 Data Bit 5 13 Select
2 Data Bit O 8 Data Bit 6 14 Auto Linefeed
3 Data Bit 1 9 Data Bit 7 15 Error
4 Data Bit 2 10 Acknowledge 16 Initialize Printer
5 Data Bit 3 11 Busy 17 Select IN
6 Data Bit 4 12 Paper End 1825 Signal Ground

Serial Interface, Powered and Non-Powered
Connector and lcon Pin Signal

|OIOI

Carrier Detect (12V if powered)
Receive Data
Transmit Data

Data Terminal Ready
Signal Ground
Data Set Ready

Request to Send
Clear to Send
Ring Indicator (5V if powered)

VOO OO WON—

USB

Connector and Icon Pin Signal

+5 VDC
SR

- Data
+ Data
Microphone
Connector and Icon (1/8" miniphone) Pin Signal

Ground
1 (Tip) Audio

Méﬂ:ﬂ: @ 2 (Ring) Power

3 (Shield)  Ground

N wN —
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Connector Pin Assignments

Headphone
Connector and Icon (1/8" miniphone) Pin Signal
1 (Tip) Audio_Left
123
@: @ ) 2 (Ring) Audio_Right
3 (Shield)  Ground
Line-In Audio
Connector and Icon (1/8" miniphone) Pin Signal
1 (Tip) Audio_In_Left
123 _ . _
S $<: 2 Ring)  Audio_In_Right
3 (Shield)  Ground
Line-Out Audio
Connector and Icon (1/8" miniphone) Pin Signal

123 $®

1 (Tip)
2 (Ring)

3 (Shield)

Audio_Out_Left
Audio_Out_Right
Ground

Monitor

Connector and Icon

(oJo]eJo]o)
[clo]e)o)

(oJoleJoJo)
Pin Signal Pin Signal Pin Signal
1 Red Analog 6 Ground 11 Not used
2 Green Analog 7 Ground 12 DDC Serial Data
3 Blue Analog 8 Ground 13 Horizontal Sync
4 Not used 9 +5V DC (fused) 14 Vertical Sync
5 Ground 10 Ground 15 DDC Serial Clock
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Connector Pin Assignments

ATA/ATAPI (IDE) Standard Drive Cable

39

Connector

1

Oooooooooao

40

2

Pin Signal Pin Signal Pin Signal
1 Reset 15 DD1 29 DMAK
2 Ground 16 DD14 30 Ground
3 DD7 17 DDO 31 INTRQ
4 DD8 18 DD15 32 IOCS16
5 DDé6 19 Ground 33 DAT
6 DD9 20 (Key) 34 PDIAG (cable detect)
7 DD5 21 DMARQ 35 DAO
8 DD10 22 Ground 36 DA?2
9 DD4 23 DIOW 37 CS1FX
10 DD11 24 Ground 38 CS3FX
11 DD3 25 DIOR 39 DASP
12 DD12 26 Ground 40 Ground
13 DD2 27 IORDY
14 DD13 28 CSEL
20-Pin Power
Connector
20 11
[=](=){)[=][=](=){][=][=](=)
(=[] L] (=) o]
10 1
Pin Signal Pin Signal Pin Signal Pin Signal
1 +3.3V 6 +5V 11 +3.3V 16 GND
2 +3.3V 7 GND 12 12V 17 GND
3 GND 8 POK 13 GND 18  open*
4 +5V 9 +5 Vaux 14 PSON 19 +5V
5 GND 10 +12V 15 GND 20 +5V
*Open for d300 series computers; -5V for all others
4-Pin Power (for CPU)
Connector and lcon Pin Signal
. s 1 GND
—
2 GND
0:10(C)=0
@E 3 +12V
2 1 4 12V

A4

359782-002

Service Reference Guide, dx2000 uT



Power Cord Set Requirements

The voltage select switch feature on the computer permitsit to operate from any line voltage
between 100-120 or 220-240 volts AC.

The power cord set received with the computer meets the requirements for use in the country
where you purchased the equipment.

Power cord sets for use in other countries must meet the requirements of the country where you
use the computer. For more information on power cord set requirements, contact your authorized
HP dealer, reseller, or service provider.

General Requirements

The requirements listed below are applicable to all countries:

1. Thelength of the power cord set must be at least 1.8 m (6.00 feet) and a maximum of 3.0 m
(9.75 feet.)

2. All power cord sets must be approved by an acceptable accredited agency responsible for
evaluation in the country where the power cord set will be used.

3. The power cord set must have a minimum current capacity of 10A and a nominal voltage
rating of 125 or 250 volts AC, as required by each country’s power system.

4. The appliance coupler must meet the mechanical configuration of an EN 60 320/IEC 320
Standard Sheet C13 connector, for mating with appliance inlet on the Switch Box.
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Power Cord Set Requirements

Country-Specific Requirements

Additional requirements specific to a country are shown in parentheses and explained below.

Accrediting Accrediting

Country Agency Country Agency
Awustralia (1) EANSW ltaly (1) IMQ
Austria (1) OVE Japan (3) METI
Belgium (1) CEBC Norway (1) NEMKO
Canada (2) CSA Sweden (1) SEMKO
Denmark (1) DEMKO Switzerland (1) SEV
Finland (1) SETI United Kingdom (1) BSI
France (1) UTE United States (2) uL
Germany (1) VDE

1. The flexible cord must be <HAR> Type HO5VV-F, 3-conductor, 1.0 mm? conductor size.
Power cord set fittings (appliance coupler and wall plug) must bear the certification mark of
the agency responsible for evaluation in the country where it will be used.

2. The flexible cord must be Type SJT or equivalent, No. 18 AWG, 3-conductor. The wall
plug must be a two-pole grounding type with a NEMA 5-15P (15A, 125V) or NEMA 6-
15P (15A 250V) configuration.

3. Appliance coupler, flexible cord, and wall plug must bear a "T" mark and registration
number in accordance with the Japanese Dentori Law. Flexible cord must be Type VCT or

VCTF, 3-conductor, 1.0 mm? conductor size. Wall plug must be a two-pole grounding type
with a Japanese Industrial Standard C8303 (7A, 125V) configuration.

B-2
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C

POST Error Messages

An error message resultsif the Power-On Self-Test (POST) encounters a problem. This test runs
when the system is turned on, checking assemblies within the computer and reporting any errors

found.

Not all computers use al of the codes listed.

Recommended Actions are to be taken in incremental steps. Perform one step at atime and
continue only if the action does not cure the problem.

POST Error Messages

Screen Message

Probable Cause

Recommended Action

Gate 20 Error

BIOS cannot access
memory over TMB.

Reseat memory modules.
Replace memory modules.

Parity Error

Fatal memory parity
error. System halts after
displaying this message.

Reseat memory modules.

Replace memory modules.

Boot Failure...

BIOS could not boot from
the device. This message
is usually followed by
information about the
specific device.

Reseat the device data and power
cables.

Replace the device data cable.
Replace the device.

Replace the system board.

Invalid Boot Diskette

Diskette in drive A: not
bootable.

Replace the diskette.

Drive Not Ready

BIOS could not configure
drive A: during POST.

Reseat the device data and power
cables.

Replace the device data cable.
Replace the device.
Replace the system board.

Drive A: Error

BIOS could not configure
drive A: during POST.

Reseat the device data and power
cables.

Replace the device data cable.
Replace the device.
Replace the system board.

Insert BOQOT Diskette In
A:

BIOS could not find a
bootable diskette in drive
A:.

Replace the diskette.
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POST Error Messages

POST Error Messages

Screen Message

Probable Cause

Recommended Action

Primary Master/Slave
Hard Disk Error

Primary Master/Slave
hard drive could not be
initialized by the BIOS.

Reseat the device data and power
cables.

Replace the device data cable.
Replace the device.

Replace the system board.

Secondary Master/
Slave Hard Disk Error

Secondary Master/Slave

hard drive could not be

initialized by the BIOS.

Reseat the device data and power
cables.

Replace the device data cable.
Replace the device.
Replace the system board.

Primary Master/Slave
Drive — ATAPI
Incompatible

Device configured as a
Primary/ Master/Slave
failed an ATAPI
compatibility test.

Replace the device.

Replace the system board.

Secondary Master/
Slave Drive — ATAPI
Incompatible

Device configured as a
Secondary/ Master/

Slave failed an ATAPI
compatibility test.

Replace the device.

Replace the system board.

S.M.AR.T. Capable
but Command Failed.

S.M.A.R.T. Command
Failed

BIOS unable to send a
S.M.AR.T. message to
the device.

Backup the data on the hard drive.
Replace the hard drive.

S.M.A.R.T. Status Bad,

Backup and replace.

S.M.AR.T. Capable
and Status Bad.

S.M.AR.T. capable hard

drive detects an imminent

failure.

Backup the data on the hard drive, then
replace the hard drive.

DMA-1 Error
DMA-2 Error

Error when initializing
secondary DMA
controller.

Reconnect the cables on the peripheral
device.

Replace the data cable.
Replace the device.

Replace the system board.

DMA Controller Error

POST error while trying
to initialize the DMA

controller.

Reconnect the cables on the peripheral
device.

Replace the data cable.
Replace the device.
Replace the system board.

Checking
NVRAM...Update
Failed

BIOS could not write to
the NVRAM block.

Change system board jumper on JP2 to
pins 2-3 (Unlock), then flash the system
BIOS. Reset the jumper to pins 1-2
(Lock).

Replace the system board.
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POST Error Messages

POST Error Messages

Screen Message

Probable Cause

Recommended Action

Microcode Error

BIOS could not find or
load the CPU microcode
update to the CPU.

Ensure the system board BIOS supports
the processor.

Change system board jumper on JP2 to
pins 2-3 (Unlock), then flash the system
BIOS. Reset the jumper to pins 1-2
(Lock).

NVRAM Checksum
Bad, NVRAM Cleared

Error detected while

validating NVRAM data.

Restart the computer, use the F10 Key to
access Computer Setup. Select Load
Default Settings > Save and Exit.

NVRAM Ignored

NVRAM data used to
store plug and play data
was not used for system
configuration in POST.

Restart the computer, use the F10 Key to
access Computer Setup. Select Load
Default Settings > Save and Exit.
Change system board jumper on JP2 to
pins 2-3 (Unlock), then flash the system
BIOS. Reset the jumper to pins 1-2
(Lock).

Replace the system board.

NVRAM Bad NVRAM data used to Restart the computer, use the F10 Key to
store plug and play data  access Computer Setup. Select Load
was not used for system Default Settings > Save and Exit.
configuration in POST. Change system board jumper on JP2 to

pins 2-3 (Unlock), then flash the system
BIOS. Reset the jumper to pins 1-2
(Lock).
Replace the system board.

Timer Error Error found while Replace the system board.

programming the count
register of channel 2 of

the 8254 timer.

Interrupt Controller-1
Error

Interrupt Controller-1
Error

BIOS POST could not
initialize the Master/
Slave Interrupt controller.

Replace the system board.

CMOS Date/Time Not
Set

CMOS Date and/or
Time is invalid.

Set the date and time under Control
Panel or in F10 Setup depending on
the operating system.

If problem persists, replace the RTC
battery.

CMOS Battery Low

CMOS battery weak.

Replace the RTC battery.

CMOS Settings Wrong

Invalid CMOS settings.

Restart the computer, use the F10 Key to
access Computer Setup. Select Load
Default Settings > Save and Exit.
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POST Error Messages

POST Error Messages

Screen Message Probable Cause

Recommended Action

CMOS Checksum Bad CMOS contents failed
the Checksum check.

Restart the computer, use the F10 Key to
access Computer Setup. Select Load
Default Settings > Save and Exit.

Keyboard Error Keyboard not present or
system not responding
when keyboard controller
is initialized.

Reconnect keyboard with computer
turned off.

Check connector for bent or missing
pins.

Ensure that none of the keys are
depressed.

Replace keyboard.

Replace system board.

Keyboard/Interface Keyboard controller
Error failure.

Reconnect keyboard with computer
turned off.

Check connector for bent or missing
pins.

Ensure that none of the keys are
depressed.

Replace keyboard.

Replace system board.
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Troubleshooting Without Diagnostics

Preliminary Checklist

This section describes some simple, preliminary tests and guidelines for troubleshooting the
computer without using the diagnostics.

Are the computer and monitor connected to aworking electrical outlet?

Is the voltage select switch is set to the appropriate voltage for your region (115V or 230V)?
I's the computer turned on?

Is the green power light illuminated?

Is the monitor turned on?

I's the green monitor light illuminated?

Turn up the monitor brightness and contrast controls if the monitor isdim.

If the system has multiple video sources (embedded, PCI, or AGP adapters) installed
(embedded video on select models only) and a single monitor, the monitor must be plugged
into the monitor connector on the source selected as the primary VGA adapter. During boot,
the other monitor connectors are disabled and if the monitor is connected into these ports, the
monitor will not function. You can select which source will be the default VGA sourcein
Computer (F10) Setup.

Press and hold any key. If the system beeps, then the keyboard is operating correctly.
Check all cables for loose or incorrect connections.

Reconfigure the computer after installing a non—Plug and Play expansion board or other
option, such as a diskette drive.

Are dl of the necessary device driversinstalled?

Have al printer drivers been installed for each application?

Remove all diskettes from the diskette drives before you turn on the system.
Are al switches set correctly?

Is the NIC Remote Wakeup cable (featured on some models) connected between the NIC
and the riser/system board?
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Troubleshooting Without Diagnostics

Solving Minor Problems

Solving Minor Problems

Problem

Cause

Possible Solution

Computer appears
locked up and will not
turn off when the power
button is pressed.

Software control of the
power switch is not
functional.

1.

Press and hold the power button
for at least four seconds until the
computer turns off.

2. Disconnect electrical plug from

outlet.

Computer will not
respond to USB
keyboard or mouse.

Computer is in
standby mode.

Press the power button to resume
from standby mode.

A CAUTION: When attempting to resume from standby mode, do not hold down the power
button for more than four seconds. Otherwise, the computer will shut down and you will lose

your data.

Computer date and
time display is
incorrect.

RTC (realtime clock)
battery may need to be
replaced.

1.

Reset the date and time under
Control Panel.

2. Replace the RTC battery.

Computer appears to
pause periodically.

Network driver is loaded

and no network

connection is established.

Establish a network connection, or
use Computer Setup or Microsoft
Windows Device Manager to disable
the network controller.

Cursor will not move
using the arrow keys on

the keypad.

The Num Lock key

may be on.

Press the Num Lock key. The Num

Lock key can be disabled (or
enabled) in Computer Setup.

Cannot remove
computer cover or
access panel.

Smart Cover Lock,
featured on some
computers, is locked.

1.

Unlock the Smart Cover Lock
using Computer Setup.

. Use the Smart Cover FailSafe

Key in case of forgotten
password, power loss, or
computer malfunction.

Poor performance is
experienced.

Processor is hot.

. Ensure airflow to the computer is

not blocked.

. Ensure the fans are connected

and working properly (some fans
only operate when needed).

. Ensure the processor heatsink is

installed properly.

Hard drive is full.

Transfer data from the hard drive to
create more space on the hard drive.
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Troubleshooting Without Diagnostics

Solving Minor Problems (Continued)

Problem

Cause

Possible Solution

Computer powered off
automatically and the

Power LED flashes Red
two times, once every

second, followed by a
two second pause.

Processor thermal
protection activated:

A fan may be blocked or
not turning.

OR

The heatsink is not
properly attached to the
processor.

1.

Ensure computer air vents are not
blocked and the cooling fan is
running.

. Open hood, press power button,

and see if the processor fan
spins. If not spinning, make sure
the fan's cable is plugged onto
the system board header. Ensure
the fan is fully/properly seated or
installed.

. Replace the processor fan.

. Reseat processor heatsink and

verify that the fan assembly is
properly attached.

System does not power
on and the LEDs on the
front of the computer
are not flashing.

System unable to power
on.

Press and hold the power button for
less than 4 seconds. If the hard drive
LED turns green, then:

1.

3.
OR

Check that the voltage selector is
set fo the appropriate voltage.

. Remove the expansion cards one

at a time until the 3.3 V_aux light
on the system board turns on.

Replace the system board.

Press and hold the power button for
less than 4 seconds. If the hard drive
LED does not turn on green then:

1.

Check that the unit is plugged
info a working AC outlet.

. Open hood and check that the

power button harness is properly
connected to the system board.

. Check that both power supply

cables are properly connected to
the system board.

. If the 3.3 V_aux light on the

system board is on, then replace
the power button harness.

. If the 3.3 V_aux light on the

system board is off, then replace
the power supply.

. Replace the system board.
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Troubleshooting Without Diagnostics

Solving Power Supply Problems

Solving Power Supply Problems

Problem

Cause

Solution

Power supply shuts down
intermittently.

Voltage selector switch
on rear of computer
chassis not switched to
correct line voltage.

Select the proper AC voltage.

Power supply fault.

Replace the power supply.

Computer powered off
automatically and the
Power LED flashes Red two
times, once every second,
followed by a two second
pause.

Processor thermal
protection activated:
A fan may be blocked
or not turning.

OR

The heatsink/fan
assembly is not

properly attached to the
processor.

1. Ensure that the computer air
vents are not blocked and the
cooling fan is running.

2. Open hood, press the power
button, and see if the processor
fan spins. If the processor fan is
not spinning, make sure the
fan's cable is plugged onto the
system board header. Ensure
the fan is fully/properly seated
or installed.

3. Replace the processor fan.

4. Reseat processor heatsink and
verify that the fan assembly is
properly attached.
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Troubleshooting Without Diagnostics

Solving Diskette Problems

Solving Diskette Problems

Problem Cause Solution
Diskette drive light Diskette is damaged. In Microsoft Windows XP, right-click
stays on. Start, click Explore, and select a

drive. Select File > Properties >
Tools. Under Error-checking,
click Check Now.

Diskette is incorrectly
inserted.

Remove diskette and reinsert.

Drive button is not
pushed in.

Push in drive button.

Files on diskette are
damaged.

Check the program diskettes.

Drive cable is not
properly connected.

Reconnect power cable. Ensure that
all four pins are connected.

Drive not found.

Cable is loose.

Reseat diskette drive data and
power cables.

Removable drive is not
seated properly.

Reseat the drive.

You attempted to hot
plug a removable
hard drive that has
Drivelock security
enabled. (This feature
supported on select
models only.)

Shut down the computer. Insert the
drive info the MultiBay, if it is not
already inserted. Turn on the
computer.

Diskette drive cannot write
to a diskette.

Diskette is not
formatted.

Format the diskette.

Diskette is write-
protected.

Use another diskette or remove the
write protection.

Writing fo the wrong
drive.

Check the drive letter in the path
statement.

Not enough space is
left on the diskette.

Use another diskette.

Diskette write control is

enabled.

Use Computer Setup to check the
storage security feature disabled
settings.

Diskette is damaged.

Replace the damaged disk.

Cannot format diskette.

Invalid media reported.

When formatting a disk in MS-DOS,
you may need to specify diskette
capacity. For example, to format a
1.44-MB diskette, type the following
command at the MS-DOS prompt:

FORMAT A: /F:1440
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Troubleshooting Without Diagnostics

Solving Diskette Problems (Continued)

Problem

Cause

Solution

A problem has occurred
with a disk transaction.

The directory structure
is bad, or there is a
problem with a file.

In Windows XP, right-click Start,
click Explore, and select a drive.
Select File > Properties >

Tools. Under Error-checking,
click Check Now.

Diskette drive cannot read

a diskette.

Diskette is not
formatted.

Format the diskette.

You are using the
wrong diskette type for
the drive type.

Check the type of drive that you
are using and use the correct
diskette type.

You are reading the
wrong drive.

Check the drive letter in the path
statement.

Diskette is damaged.

Replace the diskette with a
new one.

“Invalid system disk”
message is displayed.

A diskette that does not
contain the system files
needed to start the
computer has been
inserted in the drive.

When drive activity stops, remove
the diskette and press the
Spacebar. The computer should
start up.

Diskette error has
occurred.

Restart the computer by pressing the
power button.

Cannot Boot to Diskette.

Diskette is not bootable.

Replace with a bootable diskette.

Diskette boot has been
disabled in Computer
Setup.

Run Computer Setup and enable
diskette boot in Storage > Boot
Order.

Removable media boot
has been disabled in
Computer Setup.

Run Computer Setup and enable
Removable Media Boot in
Storage > Storage Options.

Diskette MBR validation
is enabled.

Run Computer Setup and disable
Diskette MBR Validation in
Storage > Storage Options.

Solving Hard Drive Problems

Solving Hard Drive Problems

Problem

Cause

Solution

Hard drive error occurs.

Hard disk has bad

sectors or has failed.

Use a utility to locate and block
usage of bad sectors. If necessary,
reformat the hard disk.
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Troubleshooting Without Diagnostics

Solving Hard Drive Problems (Continued)

Problem

Cause

Solution

Disk transaction problem.

Either the directory
structure is bad or there
is a problem with a file.

In Windows XP, right-click Start,
click Explore, and select a drive.
Select File > Properties > Tools.
Under Error-checking, click
Check Now.

Drive not found (identified).

Loose cable.

Check cable connections.

The system may not
have automatically
recognized a newly
installed device.

1. Run Computer Setup.

2. If the system still does not
recognize the new device,
check to see if the device is
listed within Computer Setup. If
it is listed, the probable cause is
a driver problem. If it is not
listed, the probable cause is a
hardware problem.

3. If this is a newly installed drive,
enter Setup and try adding a
POST delay under Advanced
> Power-On.

Drive jumper settings
may be incorrect.

If the drive is a secondary drive that
has just been installed on the same
cable as the primary drive, verify
that the jumpers for both drives are
set correctly.

Drive’s IDE (ATA)
controller is disabled in
Computer Setup.

Run Computer Setup and enable the
Primary and Secondary IDE (ATA)
controllers in Storage > Storage
Options.

Drive responds slowly
immediately after
power-up.

Run Computer Setup and increase
the POST Delay in Advanced >
Power-On Options.

Nonsystem disk/NTLDR
missing message.

System is trying to start
from a non bootable
diskette.

Remove the diskette from the
diskette drive.

Nonsystem disk/NTLDR
missing message.
(continued)

System is trying to start
from a damaged hard
drive.

1. Insert a bootable diskette into
the diskette drive and restart the
computer.

2. If the hard drive is sill
inaccessible and MBR Security
is enabled, try restoring the
previously saved MBR image by
entering Setup and selecting
Security > Restore Master
Boot Record.
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Solving Hard Drive Problems (Continued)

Problem

Cause

Solution

System files missing or
not properly installed.

1. Insert a bootable system
diskette and restart.

2. Verity hard drive is partitioned
and formatted.

3. Install system files for the
appropriate operating system if
necessary.

Hard drive boot
disabled in Computer
Setup.

Run Computer Setup and enable the
hard drive entry in the Storage >
Boot Order list.

Second Ultra ATA hard
drive does not perform
optimally.

Using the wrong cable
for the drive type.

Reinstall the second Ultra ATA hard
drive using an 80-conductor cable
(standard on select models.)

Both slow and fast
UATA devices are on
the same data cable.

Connect slower UATA devices to a
separate data cable connected to
the secondary IDE (ATA) controller.

Computer will not start.

Hard drive is damaged.

Observe the beeps and LED lights
on the front of the computer. See
Appendix C, “POST Error
Messages”.

Computer seems to be
locked up.

Program in use has
stopped responding to
commands.

1. Attempt the normal Windows
“Shut Down” procedure.

2. Press the power button for
four or more seconds to turn off
the power.

3. Restart the computer using the
power button.

D-8

359782-002

Service Reference Guide, dx2000 uT



Troubleshooting Without Diagnostics

Solving Display Problems

Solving Display Problems

Problem

Cause

Solution

Blank screen (no video).

The cable connections
are not correct.

Check the cable connections from
the monitor to the computer and to
the electrical outlet.

Screen blanking utility
installed or energy

saver features enabled.

Press any key or click the mouse
button and, if set, type your
password.

System ROM is bad;
system is running in

FailSafe Boot Block

mode (indicated by

eight beeps).

Reflash the ROM using a ROMPaq
diskette.

Fixed-sync monitor will
not sync at the
resolution chosen.

Ensure that the monitor can accept
the same horizontal scan rate as the
resolution chosen.

Computer is in

standby mode.

Press the power button to resume
from standby mode.

CAUTION: When attempting to resume from standby mode, do not hold down the
power button for more than four seconds. Otherwise, the computer will shut down
and you will lose your data.

Monitor cable plugged
info the wrong
connector.

If the computer system has both

an integrated graphics connector
and an AGP card connector, plug
the monitor cable into the AGP card
connector.

Monitor settings in the
computer are not
compatible with the
monitor.

1. Restart the computer and press
F8 during startup when you see
“Press F8” in the bottom right
corner of the screen.

2. Using the keyboard arrow keys,
select Enable VGA Mode
and press Enter.

3. In Windows Control Panel,
double-click the Display icon
and select the Settings tab.

4. Use the sliding control to reset
the resolution.
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Solving Display Problems (Continued)

Problem

Cause

Solution

Power LED flashes Red six
times, once every second,
followed by a two second
pause, and the computer
beeps six times.

Pre-video graphics
error.

For systems with a graphics card:
1. Reseat the graphics card.
2. Replace the graphics card.
3. Replace the system board.

For systems with integrated
graphics, replace the system board.

Monitor does not function
properly when used with
energy saver features.

Monitor without energy
saver capabilities is

being used with energy
saver features enabled.

Disable monitor energy saver
feature.

Dim characters.

The brightness and
contrast controls are not
set properly.

Adjust the monitor brightness and
contrast controls.

Cables are not properly
connected.

Check that the graphics cable is
securely connected to the graphics
card and the monitor.

Blurry video or requested
resolution cannot be set.

If the graphics
controller was
upgraded, the correct
video drivers may not

be loaded.

Install the video drivers included in
the upgrade kit.

Monitor is not capable
of displaying requested
resolution.

Change requested resolution.

The picture is broken up,
rolls, jitters, or flashes.

The monitor
connections may be
incomplete or the
monitor may be
incorrectly adjusted.

1. Be sure the monitor cable is
securely connected to the
computer.

2. In a two-monitor system or if
another monitor is in close
proximity, be sure the monitors
are not interfering with each
other’s electromagnetic field by
moving them apart.

3. Fluorescent lights or fans may
be too close to the monitor.

Monitor needs to be
degaussed.

Degauss the monitor.

Vibrating or rattling noise

coming from inside a CRT
monitor when powered on.

Monitor degaussing
coil has been activated.

None. It is normal for the
degaussing coil to be activated
when the monitor is powered on.
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Solving Display Problems (Continued)

Problem

Cause

Solution

Clicking noise coming from
inside a CRT monitor.

Electronic relays have
been activated inside
the monitor.

None. It is normal for some
monitors to make a clicking noise
when turned on and off, when
going in and out of standby mode,
and when changing resolutions.

High pitched noise coming
from inside a flat panel
monitor.

Brightness and/or
contrast settings are too

high.

Lower brightness and/or contrast
settings.

Fuzzy focus; streaking,
ghosting, or shadowing
effects; horizontal scrolling
lines; faint vertical bars; or
unable to center the picture
on the screen.

(flat panel monitors using
an analog VGA input
connection only)

Flat panel monitor’s
infernal digital
conversion circuits may
be unable to correctly
interpret the output
synchronization of the
graphics card.

1. Select the monitor’s Auto-
Adjustment option in the
monitor’s on-screen display
menu.

2. Manually synchronize the Clock
and Clock Phase on-screen
display functions. Download
SoftPag SP20930 or SP22333,
depending on the monitor, to
assist with the synchronization.

Certain typed symbols do
not appear correct.

The font you are using
does not support that
particular symbol.

Use the Character Map to locate the
and select the appropriate symbol.
Click Start > All Programs >
Accessories > System Tools >
Character Map. You can copy
the symbol from the Character Map
info a document.
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Solving Audio Problems

Solving Audio Problems

Problem

Cause

Solution

Sound does not come
out of the speaker or
headphones.

Software volume control
is turned down.

Double-click the Speaker icon on
the taskbar and use the volume
slider to adjust the volume.

The external speakers
are not turned on.

Turn on the external speakers.

External speakers
plugged into the wrong
audio jack.

See the sound card documentation
for proper speaker connection.

Audio cable not
connected.

Connect audio cable between CD
or DVD-ROM drive and the system
board.

Digital CD audio is not
enabled.

Enable digital CD audio:

1. From the Control Panel,
select System.

2. On the Hardware tab, click
the Device Manager button.

3. Right-click on the CD/DVD
device and select Properties.

4. On the Properties tab, make
sure “Enable digital CD
audio for this CD-ROM
device” is checked.

Headphones or devices
connected to the line-
out connector mute the
internal speaker.

Turn on and use headphones or
external speakers, if connected, or
disconnect headphones or external
speakers.

Volume is muted.

1. From the Control Panel
program, click Sound,
Speech and Audio
Devices, then click Sounds
and Audio Devices.

2. Click the Mute check box to
remove the check mark from
the box.

Computer is in

standby mode.

Press the power button to resume
from standby mode.

CAUTION: When attempting to resume from standby mode, do not hold down the
power button for more than four seconds. Otherwise, the computer will shut down
and you will lose your data.
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Solving Audio Problems (Continued)

Problem

Cause

Solution

Noise or no sound comes
out of the speakers or
headphones.

1. If using digital speakers that

have a stereo jack and want the
system to auto-switch to digital,
use a stereo-to-mono adapter
to properly engage the auto-
sense feature or use the
multimedia device properties
to manually switch the audio
signal from analog to digital.

. If the headphones have a mono

jack, use the multimedia device
properties to switch the system
to analog out.

[] 'Fyou set di?itcﬂ as the Output Mode, the internal speaker and external analog
il

speakers w
analog mode.

no longer output audio until you switch back to an auto-sense or

If you set analog as the Output Mode, external digital speakers will not function
until you change the output mode back to an auto-sense or digital mode.

Sound cuts in and out.

Processor resources are
being used by other

open applications.

Shut down all open processor-
intensive applications.

Computer appears to be
locked up while recording
audio.

The hard disk may be

full.

1. Before recording, make sure

there is enough free space on

the hard disk.

2. Try recording the audio file in a

compressed format.
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Solving Printer Problems

Solving Printer Problems

Problem

Cause

Solution

Printer will not print.

Printer is not turned on
and online.

Turn the printer on and make sure it
is online.

The correct printer
driver for the
application are not
installed.

1. Install the correct printer driver
for the application.

2. Try printing using the MS-
DOS command:
DIR C:\ > [printer port]

where [printer port] is the
address of the printer being
used. If the printer works,
reload the printer driver.

If you are on a network,
you may not have
made the connection
to the printer.

Make the proper network
connections to the printer.

Printer may have failed.

Run printer self-test.

Printer will not turn on.

The cables may not be
connected properly.

Reconnect all cables.

Printer prints garbled
information.

The correct printer
driver is not installed.

Install the correct printer driver for
the application.

The cables may not be
connected properly.

Reconnect all cables.

Printer memory may be
overloaded.

Reset the printer by turning it off for
one minute, then turn it back on.

Printer is offline.

The printer may be out
of paper.

1. Check the paper tray and refill
it if it is empty.

2. Select online.
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Solving Keyboard and Mouse Problems

Solving Keyboard Problems

Problem Cause Solution

Keyboard commands and  Keyboard connector 1. Turn off the computer.

typing are not recognized  is not properly 2. Reconnect the keyboard to the

by the computer. connected. back of the computer and

restart the computer.

Program in use has Shut down the computer using
stopped responding the mouse and then restart the
to commands. computer.
Keyboard needs Replace the keyboard.
repairs.
Computer is in Press the power button to resume
standby mode. from standby mode.

CAUTION: When attempting to resume from standby mode, do not hold down the
power button for more than four seconds. Otherwise, the computer will shut down
and you will lose your data.

Cursor will not move using  The Num Lock key Press the Num Lock key. The
the arrow keys on the may be on. Num Lock light should not be on if
keypad. you want to use the arrow keys. The

Num Lock key can be disabled
(or enabled) in Computer Setup.

Mouse does not respond to  Mouse connector is 1. Shut down the computer using
movement or is too slow. not properly plugged the keyboard.
into the back of the

2. Plug the mouse connector into

computer. the back of the computer (or the
keyboard) and restart the
computer.

Program in use has Shut down the computer using the

stopped responding keyboard and then restart the

to commands. computer.

Mouse needs repairs. Replace the mouse.

Computer is in Press the power button to resume

standby mode. from standby mode.

A CAUTION: When attempting to resume from standby mode, do not hold down the
power button for more than four seconds. Otherwise, the computer will shut down
and you will lose your data.

Mouse will only move Mouse roller ball is Remove roller ball cover from the
vertically or horizontally, or  dirty. bottom of the mouse and clean it.
movement is jerky.

Service Reference Guide, dx2000 uT 359782-002 D-15



Troubleshooting Without Diagnostics

Solving Hardware Installation Problems

You may need to reconfigure the computer when you add or remove hardware, such as an
additional diskette drive. If you install a plug and play device, Windows XP automatically
recognize the device and configure the computer. If you install a non—plug and play device, you
must reconfigure the computer after completing installation of the new hardware. In Windows
2000, select the Add New Hardwareicon in the Control Panel (for Windows XP, use the Add
Hardware Wizard) and follow the instructions that appear on the screen.

Solving Hardware Installation Problems

Problem

Cause

Solution

A new device is not
recognized as part of
the system.

Device is not seated or
connected properly.

Ensure that the device is properly
and securely connected and that
pins in the connector are not
bent down.

Cable(s) of new
external device are
loose or power cables
are unplugged.

Ensure that all cables are properly
and securely connected and that
pins in the cable or connector are
not bent down.

Power switch of new
external device is not
turned on.

Turn off the computer, turn on the
external device, then turn on the

computer to integrate the device

with the computer system.

When the system
advised you of changes
to the configuration,
you did not accept
them.

Reboot the computer and follow the
instructions for accepting the
changes.

A plug and play board
may not automatically
configure when

added if the default
configuration conflicts
with other devices.

Use Windows XP Device Manager
to deselect the automatic settings for
the board and choose a basic
configuration that does not cause a
resource conflict. You can also use
Computer Setup to reconfigure or
disable devices to resolve the
resource conflict.

Computer will not start.

Wrong memory
modules were used in
the upgrade or memory
modules were installed
in the wrong location.

1. Review the documentation that
came with the system to
determine if you are using the
correct memory modules and to
verify the proper installation.

2. Observe the beeps and LED
lights on the front of the
computer. See Appendix C,
“POST Error Messages” fo
determine possible causes.
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Solving Hardware Installation Problems (Continued)

Problem

Cause

Solution

Power LED flashes Red five
times, once every second,
followed by a two second
pause. The computer beeps
at the same rate and at the
same time as the LED
flashes.

Memory is installed

incorrectly or is bad.

1.
2.

Reseat DIMMs.

Replace DIMMs one at a time to
isolate the faulty module.

. Replace third-party memory

with HP memory.

. Replace the system board.
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Solving Network Problems
These guidelines do not discuss the process of debugging the network cabling.

Solving Network Problems

Problem

Cause

Solution

Wake-on-LAN feature is
not functioning.

Woake-on-LAN is not
enabled.

Use the Network control
application to enable Wake-on-
LAN.

Network driver does
not detect network
controller.

Network controller is

disabled.

Run Computer Setup and enable
network controller.

Incorrect network driver.

Check the network controller
documentation for the correct driver
or obtain the latest driver from the
manufacturer’'s Web site.

Network status link light
does not turn on or it
never flashes.

D The network status
light should flash
when there is
network activity.

No active network is
detected.

Check cabling and network
equipment for proper connection.

Network controller is not
set up properly.

Use the Network control
application to verify that the device
is working properly.

Network driver is not
properly loaded.

Reinstall network drivers.

System cannot autosense
the network.

Disable auto-sensing capabilities
and force the system into the
correct operating mode.

Diagnostics reports a
failure.

The cable is not securely
connected.

Ensure that both ends of the data
cable are securely connected.

The cable is attached to
the incorrect connector.

Ensure that the cable is attached to
the correct connector.

There is a problem with
the cable or a device at
the other end of the cable.

Ensure that the cable and device at
the other end are operating
correctly.

Network controller
interrupt is shared with
an expansion board.

Under the Computer Setup
Advanced menu, change the
resource settings for the board.

The network controller
is defective.

Replace the NIC or replace the
system board if the NIC is
embedded.

Diagnostics passes, but
the computer does not
communicate with the
network.

Network drivers are

not loaded, or driver
parameters do not match
current configuration.

1. Make sure the network drivers
are loaded and that the driver
parameters match the
configuration of the network
controller.

2. Make sure the correct network
client and protocol is installed.
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Solving Network Problems (Continued)

Problem

Cause

Solution

Diagnostics passes, but
the computer does not
communicate with the
network. (continued)

The network controller
is not configured for this
computer.

Select the Network icon in the
Control Panel and configure the
network controller.

Network controller
stopped working when
an expansion board was
added to the computer.

Network controller
interrupt is shared with an
expansion board.

Under the Computer Setup
Advanced menu, change the
resource settings for the board.

The network controller
requires drivers.

Verify that the drivers were not
accidentally deleted when the
drivers for a new expansion board
were installed.

The expansion board
installed is a network card
(NIC) and conflicts with
the embedded NIC.

Under the Computer Setup
Advanced menu, change the
resource settings for the board.

Network controller stops
working without
apparent cause.

The files containing the
network drivers are
corrupted.

Reinstall the network drivers, using
the Restore Plus! CD.

The cable is not securely
connected.

Ensure that both ends of the cable
are securely attached to the correct
devices.

The network controller is
defective.

Replace the NIC or replace the
system board if the NIC is
embedded.

New network card will
not boot.

New network card may
be defective or may not
meet industry-standard
specifications.

Install @ working, industry-standard
NIC, or change the boot sequence
to boot from another source.

Cannot connect to
network server when
attempting Remote
System Installation.

The network controller is
not configured properly.

Verify Network Connectivity, that a
DHCP Server is present, and that
the Remote System Installation
Server contains the NIC drivers for
your NIC.

System setup utility
reports unprogrammed
EEPROM.

Unprogrammed EEPROM.

Flash the ROM.
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Solving Memory Problems

CAUTION: For those systems that support ECC memory, HP does not support mixing ECC and non-
ECC memory. Otherwise, the system will not boot the operating system.

Solving Memory Problems

Problem

Cause

Solution

System will not boot or
does not function properly
after installing additional
memory modules.

Memory module is not
the correct type or
speed or the new
memory module is not
seated properly.

Replace module with the correct
industry-standard device for the
computer.

ECC memory modules are not
supported.

Out of memory error.

Memory configuration
may not be set up
correctly.

Use the Device Manager to check
memory configuration.

You have run out of
memory to run the
application.

Check the application
documentation to determine the
memory requirements.

Memory count during
POST is wrong.

The memory modules
may not be installed
correctly.

Check that the memory modules
have been installed correctly and
that proper modules are used.

Insufficient memory error
during operation.

Too many Terminate
and Stay Resident
programs (TSRs) are
installed.

Delete any TSRs that you do
not need.

You have run out of
memory for the
application.

Check the memory requirements for
the application or add more
memory to the computer.

Power LED flashes Red five
times, once every second,
followed by a two second
pause. Also, five
simultaneous beeps will be

heard.

Memory is installed
incorrectly or is bad.

1. Reseat DIMMs.

2. Replace DIMMs one at a time to
isolate the faulty module.

3. Replace third-party memory
with HP memory.

4. Replace the system board.

D-20
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Solving Processor Problems

Solving Processor Problems

Problem Cause Solution
Poor performance is Processor is hot. 1. Make sure the airflow to the
experienced. computer is not blocked.

2. Make sure the fans are
connected and working
properly (some fans only
operate when needed).

3. Make sure the processor
heatsink is installed properly.
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Solving CD-ROM and DVD Problems

Solving CD-ROM and DVD Problems

Problem

Cause

Solution

System will not boot from
CD-ROM or DVD drive.

The CD-ROM or DVD
boot is not enabled
through the Computer
Setup utility.

Run the Computer Setup utility and
enable booting to removable media
and verify boot order seftings.

Non-bootable CD in
drive.

Try a bootable CD in the drive.

CD-ROM or DVD devices
are not detected or driver
is not loaded.

Drive is not connected
properly or not properly
configured.

1. Reconnect power and data
cables to the drive.

2. Install correct device driver.

Movie will not play in the

DVD drive.

Movie may be
regionalized for a
different country.

See the documentation that came

with the DVD drive.

Decoder software is not
installed.

Install decoder software.

Cannot eject compact disc
(tray-load unit).

Disc not properly
seated in the drive.

1. Turn off the computer and insert
a thin metal rod into the
emergency eject hole and push
firmly.

2. Slowly pull the tray out from the
drive until the tray is fully
extended, then remove the disc.

CD-ROM, CD-RW, DVD-
ROM, or DVD-R/RW drive
cannot read a disc or takes
too long to start.

CD has been inserted
upside down.

Re-insert the CD with the label
facing up.

The DVD-ROM drive
takes longer to start
because it has to
determine the type of
media played, such as
audio or video.

Wait at least 30 seconds to let the
DVD-ROM drive determine the type
of media being played. If the disc
still does not start, read the other
solutions listed for this topic.

CD or DVD disc is dirty.

Clean CD or DVD with a CD
cleaning kit.

Windows does not
detect the CD-ROM or
DVD-ROM drive.

1. Use Device Manager to remove
or uninstall the device in
question.

2. Restart the computer and let
Windows detect the device.
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Solving CD-ROM and DVD Problems (Continued)

Problem

Cause

Solution

Recording audio CDs is
difficult or impossible.

Wrong or poor quality
media type.

1. Try using a slower recording
speed.

2. Verity that you are using the
correct media for the drive.

3. Try a different brand of media.
Quality varies widely between

manufacturers.
Solving Drive Key Problems
Solving DiskOnKey Problems
Problem Cause Solution

Drive Key is not seen as a
drive letter in Windows XP.

The drive letter after the
last physical drive is not
available.

Change the default drive letter for
the Drive Key in Windows XP.

The computer boots to
DOS after making a
bootable Drive Key.

Drive Key is bootable.

Install the Drive Key after the
operating system boots.

Solving Internet Access Problems

Solving Internet Access Problems

Problem

Cause

Solution

Unable to connect to the
Internet.

Internet Service
Provider (ISP) account is
not set up properly.

Verify Infernet settings or contact the
ISP for assistance.

Modem is not set up
properly.

Reconnect the modem. Verify the
connections are correct using the
quick setup documentation.

Web browser is not set
up properly.

Verify that the Web browser is
installed and set up to work with
your ISP.

Cable/ DSL modem is
not plugged in.

Plug in cable/DSL modem. You
should see a “power” LED light on
the front of the cable/DSL modem.

Service Reference Guide, dx2000 uT

359782-002

D-23



Troubleshooting Without Diagnostics

Solving Internet Access Problems (Continued)

Problem Cause Solution

Unable to connect to the Cable/DSL service is Try connecting to the Internet at a

Internet. (continued) not available or has later time or contact your ISP. (If the
been interrupted due to  cable/DSL service is connected, the
bad weather. “cable” LED light on the front of the

cable/DSL modem will be on.)

The CAT5 10/100 Connect the CAT5 10/100 cable
cable is disconnected.  between the cable modem and the

computers’s RJ-45 connector. (If the
connection is good, the “PC” LED
light on the front of the cable/DSL
modem will be on.)

IP address is not Contact the ISP for the correct IP
configured properly. address.

Cookies are corrupted. ~ Windows XP

1. Select Start > Control
Panel.

2. Double-click Internet
Options.

3. On the General tab, click the
Delete Cookies button.

Cannot automatically You must log on to the  Log on to the ISP and launch the
launch Internet programs. ISP before some desired program.
programs will start.
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Solving Internet Access Problems (Continued)

Problem

Cause

Solution

Internet takes too long to
download Web sites.

Modem is not set up
properly.

Verify that the correct modem speed
and COM port are selected.

For Windows XP

1.

Select Start > Control
Panel.

. Double-lick System.
. Click the Hardware tab.

. In the Device Manager areq,

click the Device Manager
button.

. Double<lick Ports (COM &

LPT).

. Right-click the COM port your

modem uses, then click
Properties.

. Under Device status, verify

that the modem is working
properly.

. Under Device usage, verify

the modem is enabled.

. If there are further problems,

click the Troubleshoot button
and follow the on-screen
instructions.
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Memory

Computers equipped with Intel-based processors come with double data rate synchronous
dynamic random access memory (DDR-SDRAM) dual inline memory modules (DIMMSs).

The memory sockets on the system board can be populated with up to four industry-standard
DIMMs. These memory module slots are populated with at |east one preinstalled memory
module. To achieve the maximum memory support, you can populate the system board with up
to 4GB of memory configured in a high-performing dual channel mode.

For proper system operation, if the computer supports DDR-SDRAM DIMMs, the DIMMs must
be industry-standard 184-pin, unbuffered PC2700 333 MHz- or PC3200 400 MHz-compliant,
2.5volt DDR-SDRAM DIMMs. The DDR-SDRAM DIMMs must also:

m  support CASlatency 2.5 0r 3 (CL =2.5 or CL=3)

m contain the mandatory JEDEC SPD information

In addition, the computer supports:

m  128Mbit, 256Mbit, and 512Mbit non-ECC memory technol ogies
m  single-sided and double-sided DIMMS

= DIMMs constructed with x8 and x16 DDR devices; DIMMs constructed with x4 SDRAM
are not supported

The following processor bus frequencies are required for the system to run at the supported
memory freguencies.

Memory Frequency Required Processor Bus Frequency

266 MHz 400 MHz, 533 MHz, or 800 MHz
333 MHz 533 MHz or 800 MHz
400 MHz 800 MHz

If amemory frequency is paired with an unsupported processor bus frequency, the system will
run at the highest supported memory speed. For example, if 2333 MHz DIMM is paired with a
400 MHz processor bus, the system will run at 266 MHz, the highest supported memory speed.

|:| The system will not start if you install unsupported DIMMs.
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Memory

DIMM Sockets

There are four DIMM sockets on the system board, with two sockets per channel. The sockets
arelabeled XMM1, XMM2, XMM3, and XMM4. Sockets XMM1 and XMM?2 operate in
memory channel A. Sockets XMM3 and XMM4 operate in memory channel B.

|:| The system board shown below may be slightly different from the one in the computer.

Item Description Socket Color
(1) DIMM socket XMM1, Channel A Black
(2] DIMM socket XMM?2, Channel A Blue
(3) DIMM socket XMM3, Channel B Black
(4] DIMM socket XMM4, Channel B Blue

The system will automatically operate in single channel mode or a higher-performing dual
channel mode, depending on how the DIMMs are installed.

m Insingle channel mode, the maximum operational speed is determined by the slowest DIMM
in the system. For example, if the system is populated with aDIMM that is 266 MHz and a
second DIMM that is 333 MHz, the system will run at the slower of the two speeds.

m Indual channel mode, the DIMM pairs must be identically matched. DIMMsin the XMM1
and XMM 3 black sockets must be identical; DIMMsin the XMM2 and XMM4 blue sockets
must also be identical. Therefore, if you have one preinstalled DIMM in socket XMM 1 and
are adding a second DIMM, it is recommended that you install an identical DIMM into the
XMM3 socket.
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4-pin power pin assignments A—4
20-pin power pin assignments A—4

A
ATA/ATAPI (IDE) drive cable pin assignments A—
4

B

battery
WT removal and replacement 6-20
real-time clock D-2

blank screen D9

C
cable select drive 4-1
cable, proper handling 57
cautions
AC power 5-1
adding devices 1-1
batteries 57
cables 5-7
cooling fan 56
installation 1-1
keyboard cleaning 5-5
keyboard keys 5-5
changing operating systems, important information
33
changing password 3-5
chassis types, illustrated 5-1
cleaning
computer 54
keyboard 5-5
monitor 5-5
mouse 5-5
clearing password 3-7
cloning tools, software 3-1
CMOS Setup
Advanced 24
Standard 24
Compaq software. See software
computer
cleaning 54
pauses D2

Index

Computer Setup
Advanced CMOS Setup 24
heading
exit without saving 2—7
hardware monitor 2—6
load default settings 2—7
password option 2—7
Periphera Setup 2-5
power management setup 2-5
save settings and exit 2—7
system information 2—4
Standard CMOS Setup 24
utilities 2-2
configuring power button 3-2
connector pin assignments A—1 to A—4
country-specific power cord set requirements B—2
customizing software 3-1

D
date and time display D-2
deleting password 3-6
delimiter characters, table 3—7
deployment tools, software 3—1
devicedrivers
installing/upgrading 1-1
obtaining 1-2
disassembly preparation, uT 6-1
disk, cloning 3-1
drive
cable select 4-1
capacities 4—7
device designation 4-1
uT 3.5" removal and replacement 6-13
UT removal and replacement 6-10
partition size 47
replacement type 4—6
Drive Key, problems D-23
drive positions, UT 6-9
dual-state power button 3-2

E
electrostatic discharge. See ESD
energy savings, settings for 3-3
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Index

entering
power-on password 3-5
setup password 3-5
error messages, POST C-1 to C4
ESD (electrostatic discharge)
information 5-2
materials and equipment 5-3
preventing damage 52
Ethernet
RJ45 pin assignments A—1
exit without saving, Computer Setup 2—7

F
Fail Safe Boot Block ROM 3-2
fan, power supply 56

FAT 32to NTFS conversion 1-2
4-pin power pin assignments A—4

front uT USB device removal and replacement 6—

14

G
grounding methods 5-3

H
hard drive
MT removal and replacement 6-13
proper handling 5-7
hardware monitor, Computer Setup 2—6
headphone pin assignments A—3
heatsink, UT removal and replacement 6-18

|
initial configuration 3-1
Internet addresses, See Web sites

J
jumper settings D—7

K
keyboard
cleaning 5-5
pin assignments A-1
keyboard delimiter characters, national 3—7
L
line-in audio pin assignments A—3
line-out audio pin assignments A—3
load default settings, Computer Setup 2—7

M
memory
dual channel mode E-2
memory, UT removal and replacement 6-6
microphone pin assignments A—2

uT
3.5" drive removal and replacement 6-13
battery removal and replacement 6-20
chassis, illustrated 5-1
disassembly preparation 6-1
drive positions 6-9
drive removal and replacement 6-10
front USB device removal and replacement 6—
14
heatsink removal and replacement 6-18
memory removal and replacement 6-6
power supply removal and replacement 6-22
power switch assembly removal and
replacement 6-15
preparation for disassembly 6-1
processor removal and replacement 6-18
speaker removal and replacement 6-16
system board removal and replacement 6-19
system fan removal and replacement 6-17
monitor
blank screen D—9
blurry video D-10
checking connections D—1
cleaning 5-5
dim characters D-10
pin assignments A-3
mouse
cleaning 5-5
pin assignments A-1

N
national keyboard delimiter characters 3—7

o

operating systems, important information about 3—
3

P
paralel interface pin assignments A—2
password

changing 3-5

clearing 3—7

Computer Setup option 2—7

deleting 3-6

power-on 2-1, 3-5

setup 34, 3-5
password security 34
Peripheral Setup, Computer Setup 2-5
POST (Power-On Self-Test) 2-1
POST error messages C-1 to C4
power button
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Index

configuring 3-2
dual-state 3-2
power cord set requirements
country specific B—2
general B-1
Power Management 3—3
power management setup 2-5
power supply
fan 5-6
KT removal and replacement 6-22
power supply, surge-tolerant 3—7
power switch assembly, uT removal and
replacement 6-15
power-on password 2—1
changing 3-5
deleting 3-6
entering 3-5
Power-On Self-Test (POST) 2-1
preinstalled software image 3—1
problems
audio D12
CD-ROM and DVD D-22
diskette D-5
display D-9
Drive Key D-23
hard drive D-6
installing hardware D—16
Internet access D-23
keyboard D-15
memory D-20
network D-18
optical drives D-22
power supply D4
printer D-14
processor, UT removal and replacement 6-18
protecting software 2-8

R
recovering system 3-2
recovery, software 3-1
removal and replacement
MT 3.5" drive 6-13
UT battery 6-20
UT drive 6-10
WT front USB device 6-14
WT heatsink 6-18
MUT memory 6-6
MT power supply 6-22
WT power switch assembly 6-15
MUT processor 6-18

UT speaker 6-16

UT system board 6-19

UT system fan 6-17
required tools and software 5-6
restoring software 2-8
ROM, upgrading 3-1

S
safety precautions, cleaning 54
save settings and exit, Computer Setup 2—7
saving energy 3-3
screws, correct size 5-6
SDRAM (synchronous dynamic random access
memory) E-1
serid interface pin assignments A—2
service considerations 56
setting
setup password 34, 3-5
timeouts 3-3
setup
software 1-2
windows 1-1
setup password
changing 3-5
deleting 3-6
entering 3-5
setting 34
setup, initial 3-1
software
Computer Setup Utilities 2-1
FailSafe Boot Block ROM 3-2
integration 3-1
Power Management 3-3
protecting 2-8
recovery 3-1
required 5-6
restoring 2-8
setup 1-2
spare part number, tamper-resistant wrench 5-6
speaker, UT removal and replacement 6-16
static electricity 52
surge-tolerant power supply 3—7
system board, uT removal and replacement 6-19
system fan, uT removal and replacement 6-17
system information, Computer Setup 2—4
system recovery 3-2

T

timeouts, setting 3-3

tools, required 56

20-pin power pin assignments A—4
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V)

upgrading ROM 3-1

URLSs (Web sites). See Web sites
USB pin assignments A—2

w

Wake-on-LAN feature D-18
warning, battery 5-7

Web sites

HP 1-2

HP support 1-1, 3-1, 3-3

PC Deployment 3-1
World Wide Web addresses. See Web sites
wrench, tamper-resistant 56

Index—4
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